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Introduction

The 89600 VSA software shown in this document has been replaced with the new
89600B software. To find out how you can see through signal complexity with the new
89600B VSA software visit www.keysight.com/find/89600B

This application note is a guide to effective measurement and troubleshooting of IEEE
802.16e OFDMA “Mobile WiIMAX™” signals, components, and systems. The most dis-
tinctive term used to describe this new technology is OFDMA or orthogonal frequency
division multiple access, and therefore we will use the term OFDMA in this note as a
compact reference to the signal and its associated standard.

This note provides a broad overview of measurement and troubleshooting approaches
for OFDMA signals, and is not limited to digital demodulation or modulation quality
analysis. Indeed, we will show that some of the most productive types of analysis for
OFDMA signals are generally grouped under the heading of time domain and frequen-
cy domain or “vector” signal analysis.

Though the measurements and principles discussed here would apply to any OFDMA
measurements, they are described with specific reference to the 89600 vector signal
analysis (VSA) software and Option B7Y IEEE 802.16 OFDMA modulation analysis.
This software can analyze signals from a wide variety of sources including spectrum
analyzers, modular VXI hardware, oscilloscopes, logic analyzers (for data already in
digitized form), and design/simulation software such as ADS.

The IEEE 802.16e OFDMA standard is a complex and extensive one, with many more
specifics than can be covered in a note of this type. This note will focus on a general
process for the most effective measurements, with examples of some typical prob-
lems you may find, paired with the measurement and troubleshooting techniques and
displays to help you most efficiently find and fix these problems.

Since the focus of this note is measurement and troubleshooting techniques, some
other topics, such as hardware configurations and step-by-step measurement in-
structions, will be covered in other documents. Please consult the “Other Resources”
summary below and the “References” section at the end of this note.
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Other resources

The focus of this application note is OFDMA, WIMAX and other Product Web site

eeiaves and cxamplos. Formore - OFDM technical references  For the most up-to-ate and complete
information on products, configura- Tech Online IEEE 802.16e OFDMA application and product information,
tions, and step-by-step instructions, webcast (archived - original presenta- please VlSI.’E our prodgct ng site at:
please consult the following additional  tion September 2005) http://seminar2. www.keysight.com/find/wimax
resources. The locations and litera- techonline.com/s/keysight_sep1505 or

ture numbers for these documents are 9o to www.keysight.com/find/wimax
listed in the “References” section at the  for an archived version)
end of this note.
Tech Online IEEE 802.16-2004 WiMAX
Free demo CD webcast (archived - original presen-
tation January 2005) http://www.
89601A VSA software with option B7Y  keysight.com/find/WiMAXeSeminar
802.16 “OFDMA modulation analysis”
in free trial license mode. The software  Effects of Physical Layer Impairments

includes example OFDMA signals and on OFDM Systems, Published in RF
extensive help text with measurement Design, May 2002

tutorials. This is available by ordering
publication number 5980-1989E.

Related Literature

Publication Title Publication Type Publication Number

Step-by-step instructions and measurement examples

Keysight 89600 Series Vector Signal Analysis Software for |EEE Self-Guided Demonstration  5989-2383EN
802.16 OFDMA Evaluation and Troubleshooting

Vector signal analyzer product information

Keysight 89600 Series Vector Signal Analysis Software Technical Overview 5989-1679EN
89601A/89601AN/89601N12
Keysight 89600 Series Vector Signal Analysis Software Data Sheet 5989-1786EN
89601A/89601TAN/89601N12
Hardware Measurement Platforms for the Keysight 89600 Series Data Sheet 5989-1753EN

Vector Signal Analysis Software
OFDMA, WiMAX and other OFDM technical references

Keysight WIMAX Signal Analysis; Part 1: Making Frequency and Application Note 5989-3037EN
Time Measurements

Keysight WiMAX Signal Analysis; Part 2: Demodulating and Trouble-  Application Note 5989-3038EN
shooting the Subframe

Keysight WiMAX Signal Analysis; Part 3: Troubleshooting Symbols ~ Application Note 5989-3039EN

and Improving Demodulation
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Measurement and Troubleshooting Sequence

When measuring and troubleshoot-
ing digitally modulated systems, it is
tempting to go directly to digital de-
modulation and the measurement tools
provided in that operational mode of
analyzers such as the 89600 Series
VSAs. We have learned from experi-
ence that it is usually better to follow
a measurement sequence instead:
one that begins with basic spectrum
measurements and continues with
vector (combined frequency and time)
measurements, before switching to
digital demodulation and modulation
analysis as shown in Table 1.

This is the sequence we will use in

this application note. The sequence

of measurements is especially useful
because it improves the chance that
you will find important signal problems
at the earliest stages of design. In par-
ticular, the time and frequency domain
measurements at the beginning of the
sequence provide for the measurement
and verification of many signal param-

eters (including many associated with
the digital modulation itself) without
performing digital demodulation. This
is an advantage in some development
situations where demodulation is not
yet available or is in some way ques-
tionable. In addition, some import-
ant measurements such as spectral
occupancy and CCDF are typically not
performed in a demodulation mode.

Itis certainly useful to make a variety
of modulation analysis measurements
on a system in question, watching for

things that look wrong or questionable.

You can find many problems that way.
However, some important defects are
not apparent in demodulation results,
or may manifest themselves different-
ly from one demodulator to another.
In situations such as this, you can
waste a great deal of time on unpro-
ductive measurement approaches or
demodulation results that are difficult
to interpret. The danger of missing
fundamental problems is particularly

acute in applications such as IEEE
802.16 OFDMA due to the complexity
of the signal and the possibility that
demodulation will fail due to relatively
subtle problems such as PRBS errors
or incorrect definition of data bursts.
Therefore, it is important to isolate
problems as early as possible in the
measurement and troubleshooting
process and to eliminate the maximum
number of simple signal problems be-
fore attempting digital demodulation.
This is especially true when working
on baseband DSP operations to create
signals with correct modulation, pilot
configuration, etc.

Table 1. A suggested measurement sequence for troubleshooting and performance verification.

Frequency,
frequency and time

Y

Basic
digital demod

Y

Get basics right,
find major problems

Signal quality numbers,
constellation, basic error

Advanced and
specific demod

vector measurements

Find specific problems
and causes
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Time and Frequency Domain (Vector) Measurements

Time and frequency domain analysis
can range from basic spectrum and
RF envelope measurements to a wide
variety of time-gated measurements,
composite spectrum measurements
such as spectrograms, and statistical
measurements such as CCDF (com-
plementary cumulative distribution
function), which may also be made in a
time-gated mode.

Table 2. Vector (combined time & frequency domain) measurements are an excellent first step in understanding

the performance of a circuit or system.

In addition to a wide range of demod-
ulators and modulation analysis tools,
the 89600 VSA software offers very
powerful and comprehensive vec-

tor signal analysis. The combination
of vector signal analysis and digital
demodulation is the most productive
measurement approach for digitally

modulated signals.

Frequency,
frequency and time

Basic
digital demod

Advanced and

Y

specific demod

U

- Wideband spectrum
- Narrowband spectrum
- Frequency and time

- Triggering, timing

- Gated spectrum

- Gated power, CCDF

- Time capture

- Spectrogram

Get basics right, Signal quality numbers,
find major problems constellation, basic error
vector measurements

Find specific problems
and causes
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Time and Frequency Domain (Vector) Measurements (continued)

Getting basics right and
finding major problems

Our approach begins with frequency
(basic spectrum) measurements and
progresses to vector measurements
that combine frequency and time
domain analysis. You can learn a great
deal about digitally modulated signals
before using digital demodulation, and
some important signal characteris-
tics not readily visible during digital
demodulation.

Some examples of problems with
digitally modulated signals which can
be found through vector analysis in-
clude malformed or truncated training
sequences (which can cause compat-
ibility issues even if digital modulation
is successful) and improper amplitude
or ranging (which may disguise itself
as digital modulation problems such
as timing errors). Even some problems
which arise in the digital modulation
process itself may be seen more readily
in the vector (and not digital demodu-
lation) mode.

Vector analysis also provides a good

opportunity to set triggering and pulse
search length to optimum values. This
ensures, for example, that a “pulse not

found” message during digital de-
modulation actually indicates a signal
problem and not just a setup problem
or variations in signal amplitude due
to modulation. Attaching clear mean-
ings to errors reported by the analyzer
enhances the value of the analyzer’s
results and makes the analysis itself
more comprehensive.

Time-varying signals require good
coordination of time domain and
frequency domain measurements.
Typically you can measure and verify
the time domain characteristics, and
then use time-related factors such as
triggers and gating to make the desired
frequency domain measurements.

The situation is particularly demanding
for signals such as WIMAX OFDMA
because the signal changes character-
istics in several significant ways, even
during a single RF burst or subframe.
For example, the preamble of a down-
link subframe may have higher power
than the rest of the subframe, and
that same preamble will have different
spectral characteristics and power
statistics from the rest of the sub-
frame. Indeed, different OFDM symbols
within the burst are also likely to have

different spectral and power character-
istics, including power statistics such
as peak/average power ratio.

Itis easiest to see these characteristics
and how they are measured through
the use of examples. The following ex-
amples will be presented in a sequence
which promotes an orderly approach
to measurements and troubleshooting,
and which enhances the chance that
problems will be found at the earliest
possible stage.



Time and Frequency Domain (Vector) Measurements (continued)

Setting up basic
measurements

The measurements described here

will illustrate the general measure-
ment approach and provide specific
examples of OFDMA analysis. While
detailed step-by-step instructions will
not be provided in this application note
(instead, see the 896000 VSA help text
and Option B7Y demonstration guide
described above), many of the menu
and dialog choices will be listed.

Demonstration software note: The
measurements made here will use the
OFDMA example signal recordings
provided with rev. 6.20 (or later) of the
89600 vector signal analyzer software.
You may obtain this software from
Keysight Technologies, Inc., install it in
a user PC, and operate it in a demon-
stration/training license mode without
the need to purchase the software or
contact Keysight to obtain a perma-
nent license. This demonstration/train-
ing license is available each time the
software is started, and the demon-
stration/training license capability
does not expire. The demonstration/
training license provides full access

to the analyzer’s detailed help facil-
ity, digital modulation tutorials, and
demonstration videos.
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Using an example recorded
signal

An excellent example signal for both
vector and modulation analysis is
provided with the 89600 VSA software
as a recording under the file name
i80216e_DL10MHz.sdf (the path to

the recordings is usually c:\Program
Files\Keysight\89600 VSA\Help\Sig-
nals\). This OFDMA downlink recording
includes slightly more than 5 RF bursts
(downlink subframes) which have a
burst length of 2.37 mSec and a repe-
tition interval of 5 mSec.

When playback is first initiated in the
89600 VSA, the analyzer is set to the
center frequency and frequency span
used when the recording was made
(though these can be changed later).
The analyzer defaults to a two-trace
display of frequency domain (spectrum)
and 90% time domain (RF envelope)
where the spectrum measurement
corresponds to the time record shown
in RF envelope form. The analyzer

also defaults to a frequency resolution
(FFT size) of 801 points and a playback
overlap of 90%. The overlap figure sets
the analyzer to construct each suc-
cessive time record in playback by
concatenating the last 90% of the
previous time record with 10% “new”
data from the next segment in the
recording file. In this way the effective
playback speed of the recording can
be adjusted, with 0% overlap yielding
a fast playback and 99.99% yielding a
very slow playback.
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Time and Frequency Domain (Vector) Measurements (continued)

Setting up triggering

Untriggered analysis of framed or
bursted signals such as OFDMA is
generally clumsy and unproductive.

It is usually vital to measure specific
portions of the signal, and this general-
ly requires a combination of triggering
and positive or negative trigger delay.
Where an external frame trigger is not
used, the analyzer can construct its
own magnitude or IF trigger from the
input signal itself. When measuring
signals with significant amplitude vari-
ation due to modulation (this certainly
applies to OFDMA), the amplitude

(RF envelope) variations can cause
false triggers during a burst. Therefore
trigger holdoff is also an important
parameter to set, though the actual
holdoff value is not critical for the
purpose of avoiding false triggering
due to modulation. Any value that is
well in excess of the temporary minima

caused by modulation will work well;
1 pSec is a good value to begin with.

Trigger holdoff has one other important
use for framed signals such as OFDMA.
Where a signal is composed of differ-
ent bursts (such as uplink and down-
link) and where the inter-burst timing
varies, holdoff can be used with IF trig-
gering to select a trigger point which

is unigue in an RF burst sequence. For
example, there may be one inter-burst
interval which is longer than all others,
and this may be repeated once in each
complete frame. Using a trigger holdoff
value which is shorter than the longest
inter-burst interval but is longer than
the other intervals will yield a single
valid trigger at a specific point in each
frame. Positive and negative trigger
delay can then be used to select any
portion of the signal for measurement,
referenced to this unique trigger point.

All of these trigger capabilities are
available whether the signal is “live”
(from input hardware) or from a record-
ing. Triggers based on the recorded
signal are grouped under the Playback
Trigger tab of the Input menu.

While these trigger capabilities can

be used in the digital demodulation
mode as well, typical demodulation
measurements are made with the
“pulse search” functions specific to a
demodulation type. These pulse search
functions are in some ways more
advanced than the triggering described
here. The most common exception to
this practice occurs when pulse search
is unsuccessful or unreliable in demod-
ulation operations, perhaps leading

to questions about the validity of the
pulses constructed by the system. In
cases such as this the normal trig-
gering and holdoff functions can help
identify defective bursts.
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Time and Frequency Domain (Vector) Measurements (continued)

When making triggered measurements

m Keysight 89600 Vector Signal Analyzer

on RF bursts, a good practice is to be- : -
gin by setting a negative or pre—trigger Ele Edit Control Source Input TestSetup MeasSetup Display Trace Markers Utiities Help
Stacked2 ¥ o g
delay of approximately 10% of the time Hniej0@OO OO s A=l 8
. &: Ch1 Spectium Range: -10 dBm
record. Then choose an appropriate 20 ] [
trigger holdoff value and adjust trigger B LTRSS TRV
) . | Ll Y |
level until a stable measurement is Leghtag
produced in the frequency and time 10
. . dB
domain. For the following measure- Jdiv 1l Lo, iMi.,i
ments on the i80216e_DL10MHz. _mwl-mr'{w ‘h“ e ]
sdf recorded signal, a trigger level of dBm
. Center: 2.31 GHz Span: 20 MHz
10 mV, a trigger holdoff of T uSec, and REW: 100 kHz TimeLen: 38.20312 uSec
a pre-trigger delay of -3 uSec works _mB: Ch1 Main Time J ‘ Range: 100 m/
well. See Figure 1. dBVpk o f Pty ¥ "y |
LDgMag """""" O e Y’ = ['—'r't'—— ———————————————— RS et e SR EER R RS R R
10
dB
fdiv
110
dBvpk
Start: -4 uSec Stop: 34.164 uSec
Trig: Ch 1 Delay: -4 uSec Trig Lvl: 10 mV/

Figure 1. Triggered measurement of spectrum and RF envelope with negative trigger
delay, showing leading edge of burst. Horizontal dashed line on RF envelope shows
trigger level.



Time and Frequency Domain (Vector) Measurements (continued)

Basic measurements of the
preamble

With the measurement stabilized, you
can configure the analyzer to deter-
mine some basic signal parameters.
Measuring the preamble of this down-
link signal is a good place to begin, as
the characteristics of this portion of
the subframe are stable and well-de-
fined. Since the preamble is 1 OFDM
symbol time in length and may have a
different power level than the rest of
the subframe, it makes sense to set a
time record length of about 2.5 times
the OFDM symbol length, or about
250 pSec.
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Given a particular frequency span
(and resulting sample rate), FFT size,
and RBW/window configuration there
is a limit on the maximum length of a
time record. For the 20 MHz span and
801 point FFT size of the analyzer's
default configuration, this maximum
time length is about 40 pSec. Since
the desired length for this measure-
ment is 250 pSec and since maximum
time length and number of FFT points
scale linearly, we need an FFT length
approximately 6 times longer than
the default 801 points. The ResBW
tab of the MeasSetup menu provides
a Frequency Points setting, and we
should thus select a number of 6401
or greater from the binary sequence in
the drop-down list.
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Time and Frequency Domain (Vector) Measurements (continued)

Once the number of points is in-
creased, the Main Time Length can be
set on the Time tab of the MeasSetup
menu to 250 puSec. The resulting time
domain display now clearly contains
the turn-on event, the preamble, and
the first symbol following the pream-
ble, along with the spectrum of this
time segment. It is then a straightfor-
ward matter to use the band power
marker tool and the mouse to measure
both the power and time duration of
the preamble, as shown in Figure 2. In
the same way, we can select the occu-
pied bandwidth marker for an approxi-
mate measure of the bandwidth of the
signal. The default power percentage

for occupied bandwidth measurements
can be changed, though this is not a
particularly precise measurement for
signals such as OFDM, which have
varying sideband levels.

Since the band power marker length
was set visually from the appearance
of the RF envelope trace, the length
setting (shown in the Calculation tab of
the Markers menu, after selecting trace
A) is a good way to verify approximate
preamble (and therefore also OFDM
symbol) length. In this way, you can
measure and verify many of the basic
parameters before attempting opera-
tions such as digital demodulation. At

ﬁi Keysight 89600 Vector Signal Analyzer

QE OO E® ® stacked2

A: Chl Spectium

Pn e

Ele Edit Control Source Input TestSetup MeasSetup Display Irace Markers Utiities Help

=R
Range: -10 dBm

-20 | \

dBm | |
Loghag
10 o

1LY

dB |

feliv Fi

1204

dBm L

Center: 2.31 GHz
RBW: 15.2774 kHz

B: Ch1 Main Time

Span: 20 MHz
TimeLen: 250 uSec

0]
dBvpk

LoghMag S h

Range: 100 mv

10

dB :

.’div“

100 |

dBvpk [ | H

Start: -4 uSec

Stop: 245.96 uSec

Trig: Ch1 Delay: -4 uSec Trig Lvl: 10 m¥

OBW: 9 130 125.71 Hz
Power:

Trace &
Tzace B

Centzroid: 2 305 872 505.40 Hz Offset: -

Figure 2. Occupied bandwidth and band power measurements; numeric results are
shown at the bottom of the display.

this point it might be useful to use the
mouse on the dashed vertical band
power center line to drag the band
power markers to the first symbol after
the preamble. This would provide a
good relative or absolute measurement
of the relative power level of the OFDM
symbols.



13 | Keysight | IEEE 802.16e WiMAX OFDMA Signal Measurements and Troubleshooting - Application Note

Time and Frequency Domain (Vector) Measurements (continued)

Time-gated spectrum

You can make more precise and more
specific measurements of spectrum
and signal bandwidth, and of critical
parameters such as carrier spacing
using time-gated spectrum measure-
ments on a frequency span just ade-
quate to cover the signal. In this case
a good choice for frequency span is 10
MHz, and this parameter (along with
the center frequency, if desired) can
be changed on a recorded or captured
signal.

You can set up time-gated measure-
ments visually by using the mouse, or
numerically through the menus. In this
case it is convenient to set specific
parameters such as the gate length
using the Time tab on the MeasSetup
menu, and then move the gate window
visually to align with the preamble.

For optimum spectrum resolution, you
should set the gate window to match
the OFDM symbol time of 102.9 uSec,
and set the Window Type (RBW shape)
on the ResBW tab of the MeasSetup
menu to Uniform. The uniform window
is a good choice for self-windowing
functions such as OFDM symbols, pro-

viding maximum frequency resolution
for a given gate (time record) length.
If necessary (as the result of other
parameter changes) you should reset
the main time length to a value such
as 250 pSec, to allow measurement of
different portions of the signal. Such

a measurement is shown in Figure 3,
where the gated spectrum measure-
ment in trace A is the result of the gate
window placed in trace B.

The individual carriers are resolved in
trace A, and the offset marker function
is used to measure their frequency dif-
ference. By measuring the outermost
carriers and dividing by the number

of carriers, an accurate (more accu-
rate than one derived from occupied

bandwidth) measurement of carrier
spacing can be made without the need
for digital demodulation. This gated
measurement is particularly well-suit-
ed to the preamble, where only every
third OFDM carrier is transmitted

and individual carriers are thus easily
resolved and examined. The expanded
X-axis scaling of trace C (about 10:1)
shows both the untransmitted center
carrier and the individual subcarriers in
the preamble in more detail. If desired,
you can move the gate window to the
symbol following the preamble by
dragging the left gate marker with the
mouse or increasing the numerical gate
delay (and therefore the start of the
gate) by T OFDM symbol time.

| Elle Edit Control Source Input TestSetup MeasSetup Display Trace Markers Utiities Help
rnle @A®EOE O stdds koo |11 E
&: Chl Gate Spectrum Range: -10 dBm
-20 I ] I T T T T ]
dBm| 5 P—
=~ i 1 1 ! L -
Az0-t | I
dém| 1 -
Center: 2.31 GHz Span: 10 MHz
RBW: 9.71168 kHz GateLen: 102.9687 uSec
B: Ch1 Main Time | ; Range: 100 mV
0k I | [ S E T D ]
dBpl L CTTE T T LB Al | B Ll Jul L
| H | |
-110
dBVDk| |
Start: -4 uSec Stop: 245.92 uSec
Trig: Ch1 Delay: -4 uSec Trig Lyl 10 mV
C: Ch1 Gate Spectrum Range: -10 dBm
] E— ! |
Bmlag_ A _p a nn A Alg ~ [ o Py Py A A A A AW A_Nlns A
A L A A A A S
¥ Almmanls ,4\l]|l(|ﬁli, ,i‘][i W—JFENE\!' Iy IR LA UL
-75 | I I— I - T
cBm +———H T l T————
Left: 2.3094571394 GHz Right: 2.3105514793 GHz
REW: 9.71168 kHz GateLen: 102.9687 uSec
Trace B Offser: 3 ZE5 337.% Hz -0.815 d2

Figure 3. Gated spectrum measurement of only the downlink preamble. The gate
windows are shown in trace B and the entire subcarrier set (every 3rd carrier) is shown
in trace A. In trace C the X-axis of the middle portion of trace A is expanded to show
individual subcarriers and the missing center carrier.
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Time and Frequency Domain (Vector) Measurements (continued)

Measuring subframe timing

A three-trace display and X-axis scale
expansion is also useful for measuring
the actual burst length and turn-on/
turn-off behavior of the signal. To ob-
tain a sufficiently long main time (time
record) length, the number of frequen-
cy points must be expanded again, this
time to 25,601. Then a combination of
offset markers, X-axis scale expansion,
and marker coupling between all three
traces produces the measurement
shown in Figure 4.

Marker offset references can be se-
lected separately or together for each
trace. In this measurement the refer-

ence for the offset marker signifies the
beginning of the RF burst and is set on
trace B. The end of the RF burst can be
most easily set by placing a marker on
trace C (which places a marker at the
same time point on trace B, though it is
off-scale to the right), and the RF burst
time duration can be read from the
offset marker B value at the bottom of
the screen.

Marker coupling is particularly useful
for measurements such as this, where
the measurement data far exceeds
what can be shown on a normal-
ly-scaled trace. The offset markers
could also be used on individual traces
to measure the power ramps.

LI

DB O D@ ® Stacked3

Ele Edit Control Source Input TestSetup MeasSetup Display TIrace Markers Utilities Help

- % 2o 11| B

iA: Chi Maitl'l Time | | : Range: 100 mV
i] ] I ] I I 1
dBVpk
100 i i  — i 1 f
dBvpk | = ' I t I ' i i
Start: -4 uSec Stop: 2.4959 mSec
Trig: Ch1 Delay: -4 uSec Trig Lyl 10 m¥
B: Ch1 Main Time : Range: 100 mV
-10 VAV L L [ AT
dBvpk 24 1% = S PR, P S S, S B SR L LR, g, R e ..\'_W
'"U’WWI
dBvpk
Left -4 uSec Right: 50 uSec
Trig: Ch1 Delay: -4 uSec Trig Lyl 10 my
C: Ch1 Main Time Range: 100 mV
10 I I I
dBVpk j— — + — -
T T e s e
an l s I I Ll — 2
dBYpk 1 ! S—— ' by -
Left: 2.33 mSec Right: 2.38 mSec
Trig: Ch1 Delay: -4 uSec Trig Lvl: 10 my
Z.38E715 meee
Tzace B Offset: 2.366715 mSec 2.5€5 43
Trace C Marker: 2.386462 mSec -53.762 dBVpk

Figure 4. RF envelope of the entire subframe (top trace) along with expanded-scale
views of the turn-on and turn-off events (lower traces). Coupled offset markers are used

with the expanded scaling to accurately m
varying power of the RF burst envelope as

easure the subframe length. Note also the
shown in trace A.

Gated vector measurements are useful
for a variety of tests not involving
digital demodulation. For component
manufacturers, for example, statistical
power measurements such as CCDF
provide important information for com-
paring different amplifiers or power
settings.
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Time and Frequency Domain (Vector) Measurements (continued)

CCDF measurements

As with spectrum measurements,
CCDF measurements are most

valid and consistent when made in a
time-gated mode. In particular, for a
signal such as OFDMA, where signal
structure and modulation (and there-
fore power statistics) change during a
subframe, it can be very useful to make
measurements focused on particular
parts of the signal. Alternatively, mea-
surements can be made on the same
signal both before and after a partic-
ular component (such as an amplifier)
or operation (such as filtering or crest
factor reduction) to better understand
the effects.

Il Keysight 89600 Vector Signal Analyzer

The setup for time-gated CCDF is very
similar to that used for the gated spec-
trum measurements of Figure 3. For
illustration, the CCDF of the preamble
is measured and saved in a data regis-
ter. Itis then overlaid with a measure-
ment of a later portion of the subframe
which uses all subcarriers. The result is
shown in Figure 5.

As can be seen from the RF envelope
trace, the power statistics are quite
different for the preamble and later
portions of the subframe. At the 1%
probability point the peak/average
power ratios are almost 3 dB different!
Note that while the actual average
power levels of the preamble may be

Ele Edit Control Source Input TestSetup MeasSetup Display Trace Markers Utilities Help

B: Chl Gate CCDF

rnle @OODE O stked2 k3o il M|||E
£: Chl Main Time Range: 100 mV
0 [ [ [ I [ [ | |
dBvpk | ol | I PP T T
LogMag || 1
10 ]
dB
Adiv
100
dBvpk
Statt: -4 uSec Stop: 245.92 uSec
Trig: Ch 1 Delay: -4 uSec Trig Lyl 10 mV

Pts:21.1k Avg:-16.65 dBm

Range: 100 mV

Tzaee D Markex:

Figure 5. Time-gated CCDF of preamble and data portion of OFDMA downlink subframe
overlaid (bottom trace). The gate window is shown in the upper trace and a reference

AWGN curve is shown by a gray line in the lower trace. Specific peak/average power
figures for the 1% probability point are listed in the marker table for comparison.

different from the rest of the subframe,
the CCDF calculations normalize this
difference out. In a similar way, the
CCDF of different portions of the RF
burst (as shown by the power varia-
tions in the top trace of Figure 4) could
be measured by graphically or numeri-
cally placing gate markers.
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Time and Frequency Domain (Vector) Measurements (continued)

Spectrograms

With a comparatively wide band-
width,long time length, and large num-
ber of carriers, an OFDMA subframe
typically contains a large amount of
data. Most time and frequency domain
displays, however, contain a limited
amount of information. Spectrograms
are an excellent way to present a large
amount of spectral information on

a single screen by using color as an
additional information axis. To do this,
each individual spectrum measure-
ment is reduced to one pixel row in
height, and amplitude is encoded as a
color or brightness value. By stacking
successive spectrum measurements,
the Y-axis of the display is a time axis.
In this way hundreds of spectrum
measurements can be presented on a
single display, enhancing the visibility
of subtle spectral effects.

Spectrograms are particularly useful
when made from signal recordings,
since the analyzer is in a real-time
analysis mode during recording and
playback, ensuring that the mea-

surement data is contiguous and no
signals are missed. In addition, the
adjustable overlap parameter available
for playback allows you to adjust the
time interval represented by succes-
sive spectrum measurements (and
therefore the vertical time scale of the
spectrogram) as needed to optimize
the measurement.

Spectrograms covering bandwidths
much wider than the OFDMA channel
can be useful for detecting interfer-
ence and understanding band usage.
For the purposes of this application
note, however, we will discuss the use
of a time-gated spectrogram of the
downlink subframe previously ana-
lyzed. The setup is essentially the same
as the gated spectrum measurements
in Figure 3, with a 1 symbol gate length
and a uniform window shape. Trig-
gering (specifically Playback Trigger-
ing) should be switched off for these
spectrogram measurements and Max
Overlap for this example time capture
should be set to 98-99%.
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Time and Frequency Domain (Vector) Measurements (continued)

For this measurement, Y-axis scaling

should be reduced (to 2 dB/division in ¥ Keysight 89600 Vector Signal Analyzer

this eXample) to emphasize spectral | Ele Edit Control Sgurce Input TestSetup MeasSetup Display Irace Markers Utiities Help
changes associated with OFDM symbol ynle @@ O DEE steded2 e il g %
transitions. You can then increase and 4 Chl Gate Spectrum '

adjust the overlap, first to show the 0 ot
initial symbols of the subframe, and ;
later to show the entire subframe and
its changing spectral content. As need-
ed, you can adjust the spectrogram

enhancement parameter to emphasize ‘ ;ﬂ.
the amplitude range of interest. The Center 231 GHz —
symbol transitions are most clearly ik 160 e rateliony 118901120

. . B: Ch1 Gate Spectrum Range: -10 dBm
seen in color displays. .Bgu | |

m

For the first measurement, the analyz- Loglag ]
er’s Trace Select spectrogram marker 5 W - i
will be used. This allows one spectrum ;fﬁ?,_" il | | |_ | .. [ 1l L _. I " T
measurement to be selected from the _an" ! II' ! I U8 I |
spectrogram and displayed in another dBm T | S TG
display trace, as shown in Figure 6. REW: 9.71168 kHz GateLen: 1029687 uSec

Figure 6. Spectrogram and spectrum measurements of preamble and first symbols of
downlink subframe. The Trace Select marker is used in spectrogram to identify
individual spectrum measurement for display in bottom trace. Note that the occupied
bandwidth of the signal is somewhat wider during the preamble.



Time and Frequency Domain (Vector) Measurements (continued)

Correlating a spectrogram
with data bursts

Since this example signal contains sev-
eral different data bursts in each of two
different zones, and each zone contains
a combination of data-carrying and
unoccupied (pilots-only) symbols, it is
possible to match the subframe with the
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match, the data burst maps (which

use logical subchannels as their Y-axis
and OFDM symbol index/time as their
X-axis) will be rotated 90 degrees and
aligned with the spectrogram to pro-
duce the graphic shown in Figure 7. The
window (RBW) shape has been returned
to the default flat top shape to show the
increased sideband energy that marks

data burst maps used by the analyzer
for digital demodulation operations in
OFDMA analysis. To perform this visual

the symbol transitions on either side of
the spectrogram.
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Figure 7. Spectrogram (left) and data burst maps (right) aligned to show the same events in
time (Y-axis). The change in OFDMA subcarriers corresponding with data bursts and logical
subchannels is clearly shown. Note in particular the different spectral characteristics
associated with data-carrying symbols and unoccupied (pilot carriers only) symbols.



Time and Frequency Domain (Vector) Measurements (continued)

By adjusting the spectrogram parame-
ters, the structure of the subframe and
its data bursts is revealed. Even the tim-
ing of the individual symbol transitions
can be seen by the temporary increase
in sidelobe energy at the left and right
edges of the spectrogram. Especially
distinct spectral changes are obvious

in the latter part of each zone, where
the data bursts have ended and only
pilot subcarriers are transmitted. The
changing subcarrier numbers of these
pilots from symbol to symbol are also
shown in the spectrogram. With X-axis
scaling and the spectrogram’s Trace
Select function, you could see details of
pilot and subcarrier behavior on a sym-
bol-by-symbol basis. In general, the use
of the uniform window (Figure 3 above)
provides the best frequency resolution
for resolving OFDM subcarriers, and the
flat top and Gaussian windows provide
the dynamic range to reveal the symbol
transitions.
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Vector measurements
summary

As the examples here show, you can
understand, measure, and verify many
of the most important characteristics
of the OFDMA signal before performing
digital modulation analysis. Indeed, the
use of vector time and frequency do-
main analysis to more fully understand
the signal and its characteristics will
improve digital modulation analysis and
may reveal to you problems or impair-
ments which would otherwise remain
obscure.
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Basic Digital Demodulation

The goal of basic digital demodulation
is successful and valid demodulation
of the signal (a “locked” demodulation
result with correctly detected symbol
states, etc.). This demodulation will
produce a wide variety of valid modu-
lation quality measurements plus basic
error displays primarily in terms of time
(or OFDM symbol) and frequency (or
OFDM subcarrier).

The information gained during initial
vector measurements enhances the
reliability of digital demodulation mea-
surements and the insight provided by
them.

For some measurement tasks, espe-
cially design verification, basic digital
demodulation will be sufficient. The er-
ror summary table provides a complete
numeric summary of signal quality and
the magnitude of major error types.

A large amount of measurement data
is available at this stage and you can
perform significant troubleshooting as
well. Error vector time and frequency
measurements, in particular, are an
excellent way to begin tracking down
potential problem sources.

One powerful technique (often over-
looked, and not available in many other
product solutions) is to use marker

coupling to link error measurements
across different domains. Error sources
may be invisible in one measurement
type and obvious in another. This is
particularly true in multicarrier formats
such as OFDMA, and we will discuss
some examples of the use of marker
coupling in this note.

Table 3. Basic digital demodulation measurements verify proper modulation and quantify the main error
parameters such as EVM vs. symbol and subcarrier.

Frequency,
frequency and time

Basic
digital demod

Y

Get basics right,
find major problems

Signal quality numbers,
constellation, basic error
vector measurements

Advanced and
specific demod

L |

- Set up demod and
- Constellation
— Error summary

- Error vector

- Error vector time
- Cross-domain

- Parameter

- More time

displays

spectrum

and cross-
measurement
links

adjustment

capture

Find specific problems
and causes



Basic Digital Demodulation (continued)

Understanding I/Q errors in

OFDM

One excellent reference on trouble-
shooting OFDM signals is an RF Design
magazine article by Robert Cutler of
Keysight Technologies. A summary table
from that article is shown here (with a
table error corrected). You can find this
reference in the Resources section at

the end of this application note.
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VSA'’s digital demodulation measure-

ment displays. Fortunately, impairments
and defects (such as flatness/frequency

other modulation types.

Note, in particular, that many types of
signal impairments do not provide the
distinctive error displays in OFDM that
they would in single-carrier modulation.
Understanding the specific type of error
is a primary use of many of the 89600

response, symbol timing, phase noise,
frequency error, EVM, I/Q defects, etc.)
have the same appearance as they do
for IEEE 802.16 OFDMA WiIMAX. Also,
some of the setup parameters can be
entered the same way as they are for

Table 4. Using constellation displays to determine OFDM signal impairments is

somewhat more complicated than for signals with single-carrier modulation.

Impairment
IQ gain balance

OFDM
State spreading (uniform/carrier)

Single carrier modulation (SCM)
Distortion of constellation

1Q Quadrature skew

State spreading (uniform/carrier)

Distortion of constellation

|Q channel mismatch

State spreading (nonuniform/carrier)

State spreading

Uncompensated frequency error

State spreading

Spinning constellation

Phase noise

State spreading (uniform/carrier)

Constellation phase arcing

Nonlinear distortion

State spreading

State spreading (may be more pronounced on outer states)

Linear distortion

Usually no effect (equalized)

State spreading if not equalized

Carrier leakage

Offset constellation for center carrier

Offset constellation

Frequency error

State spreading

Constellation phase arcing

Amplifier droop

Radial constellation distortion

Radial constellation distortion

Spurious

State spreading or shifting of affected

State spreading, generally circular
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Basic Digital Demodulation (continued)

Capturing a signal for analysis

To make accurate demodulation mea-
surements, the analyzer setup must
match the signal. This matching process
may involve some experimentation with
demodulator settings and character-
istics, and the use of the 89600 VSA's
time capture can be very helpful in this
effort. By capturing one or more exam-
ples of the signal for repeated playback,
you can be assured that any changes

in the demodulation result (including
both success/failure of demodulation
and changes in measured signal quality)
are the results of the intended setup
changes and not a consequence of
changes in the signal itself. This ap-
proach reduces the number of variables
in signal analysis and troubleshooting
and improves the chances for consistent
and meaningful results. The use of time
capture files has additional benefits,
allowing you to archive signals for future
comparisons and providing an easy
method to distribute signals to different
design teams.

In the 89600 VSA, time capture opera-
tions primarily require the setting of an-
alyzer center frequency and span, and
selection of a capture length. Generally
a frequency span of 1.2 to 1.5 times the
nominal bandwidth is sufficient. The
center frequency need not be exact, as
you can change both center frequen-
cy and span after signal capture. You
can set the length of the time capture
in terms of samples (expressed as a
number of time records) or time. For
signals such as those described here,

a capture of one to five frames should
be sufficient. The time capture opera-
tion can be a triggered event, and it is
useful to trigger on the rising edge of
the burst, with a negative (pre-trigger)
delay of 5 to 50% of the burst length.
Trigger holdoff, if necessary, should be
set as described previously in the vector
measurements section of this note.



23 | Keysight | IEEE 802.16e WiMAX OFDMA Signal Measurements and Troubleshooting - Application Note

Basic Digital Demodulation (continued)

Two types of demodulation
measurements

When analyzing OFDMA signals with
the 89600 VSA software, there are two
types of demodulation measurements to
make: “uniform” mode and “data burst”
mode. In a uniform mode measurement,
the analyzer assumes that the signal
will have only one type of modulation
and one power level throughout the
permutation zone to be analyzed. In
“data burst” analysis, the analyzer
demodulates the signal according to a
subchannel-by-symbol (or “slot”) “zone
definition” grid that the user creates or
provides in the form of a setup file. This
grid indicates the type of modulation
used for each logical subchannel and
each symbol of the subframe, allow-

ing the analyzer to demodulate and
display the individual data bursts, either
separately or together, and to produce a
Data Burst Info summary results table,
which will be described later in this
note.

One good approach for getting demod-
ulation working and making modulation
error measurements with the mini-
mum amount of difficulty is to limit the
complexity of the signal. An excellent
way to limit the complexity of the signal
is to use a “uniform” signal. As used in
this note, the uniform signal is limited
to a single modulation type and uses
all logical subchannels (and therefore
all subcarriers) for the entire subframe.
The power of the uniform signal remains
constant for each symbol in the sub-
frame. In addition, the pilots (relative

to which the signal is demodulated) are
easy to find.

This simplified signal is not an appro-
priate one for normal system operation,
since one of the limitations on its com-
plexity is its lack of a QPSK-modulated
frame control header (FCH).

The uniform signal offers benefits for
both signal creation and signal analysis.
On the creation end, the uniform signal
can be created in the same way that
simpler OFDM signals are, reducing the
chance for DSP or other errors in signal
creation which might be confused with
errors in modulation analysis (param-
eter) setup, demodulation algorithms,
etc.

Since the uniform signal is generally
representative of other signals in terms
of spectrum and power statistics, itis a
good test signal for testing part or all of
the RF signal chain. The uniform signal
is spectrally correct and usually correct
for power statistics as well: these statis-
tics should approach the AWGN curve.
While downlink signals can change
power during a subframe, for a single
OFDM symbol, the CCDF power statis-
tics should be similar between uniform
and nonuniform signals.
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Basic Digital Demodulation (continued)

Downlink modulation quality
measurements of a uniform
signal

This downlink analysis will use the ex-
ample downlink recording i80216e_DL-
PuscUniformQ64.sdf supplied with the
89600 VSA software. Many important
characteristics of this signal can be
determined using the techniques
described previously in the vector
measurements section of this note.

For example, the signal is 22 OFDM
symbol times long in total, including 20
symbols of 64QAM data plus the pre-
amble. This uniform signal occupies all
of the slots in the zone, which means
that all of the OFDM subcarriers are
active throughout the subframe and
are modulated with 64QAM (except for
the pilots, which are modulated with
BPSK).

As described above, it is generally
helpful to make the vector (time enve-
lope and spectrum or gated spectrum)
measurements on a signal before
setting up to perform digital demodu-
lation. Accordingly, it is assumed here
that the signal has no gross uncorrect-
ed defects that could be seen in vector
mode, and which could be expected to
prevent digital demodulation.

Whether entered directly or derived
from the vector measurements de-
scribed previously, it is assumed that
the signal analyzer’s amplitude pa-
rameters (attenuation or input range),

frequency parameters (center, span)
and trigger conditions (external/inter-
nal and trigger level delay and holdoff,
if necessary) have been correctly set.
In many cases the VSA’s pulse search
capability will eliminate the need for
triggering and for selecting parameters
including holdoff.

Set the center frequency to the most
accurate value known or derived

from previous measurements. The
analyzer will calculate the precise
center frequency of the signal during
the demodulation process, and the
analyzer will also report the errorin
the error summary table. In general,
the demodulation algorithms should
operate well on OFDMA signals where
the selected center frequency is ac-
curate to within about one half of the
OFDM carrier spacing. If you suspect

a configuration error larger than this
value, you can configure the 89600
VSA software for a larger demodula-
tion carrier lock range by selecting the
Extend Frequency Lock Range check
box in the Advanced tab of the OFDMA
Demodulation Properties dialog box.
This expanded lock range is only avail-
able for uplink signals, due to their lack
of a preamble. Once a more accurate
center frequency is derived from a
locked demodulation measurement,
that frequency should be selected as
the analyzer center frequency, and you
should clear the Extend Frequency
Lock Range box to yield the most sta-
ble and accurate demodulation results.

Recall that when using recorded
signals with the 89600 VSA, you can
change the analyzer's center frequency
and span during any stage or mode

of analysis - even after the recording

is made. This is true so long as the
desired analysis span is contained fully
within the original recording span.

The default demodulation settings for
the 89600 VSA include a pulse search
function, so triggering is not usually
necessary for pulsed signals such as
most OFDMA downlink and uplink
signals. However, if the signal under
test includes both uplink and downlink
signals, and/or if the intent is to mea-
sure a specific RF burst among others,
you would normally use triggering. This
triggering can be internal triggering,
where a combination of trigger level,
negative/positive trigger delay, and
trigger holdoff are used to select the
desired RF burst. Alternatively, you
can use external triggering when an
external trigger signal is available.
Both negative and positive trigger
delay are available for this trigger type,
and they can be used to measure a
specific burst even if the trigger is not
coincident with the burst. Indeed, you
would ordinarily use external triggering
to examine the relationship between

a supplied trigger signal and RF burst
power (vector mode) or between a
supplied trigger and data modulation
(digital demodulation mode).
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Basic Digital Demodulation (continued)

The first step in digital demodulation is
to select the demodulation mode. You
do this from the analyzer’s MeasSetup
> Demodulator > Broadband Wireless
Access menu sequence, where 802.16
OFDMA is chosen. The next step is to
bring up the 802.16 OFDMA Demodula-
tion Properties dialog box (MeasSetup
> Demod Properties) and its four tabs,
beginning with the Format tab, as
shown in Figure 8.

The Format tab contains a drop-down
list used to select the applicable
standard. This selection should be
the first action you take in setting up
digital demodulation. Selecting the
standard configures certain proper-
ties of the demodulator, as described
in detail in the analyzer’s online Help
facility. Next to this box is the Preset to
Standard button, and it is generally a
good idea to use this button once the
standard is selected. There are very
many measurement configuration and

demodulation parameters to set when
performing OFDMA demodulation, and
this button will reset most of them,
reducing the chance that parameters
specific to a prior measurement will be
incompatible with the current one.

The 89600 VSA software supports two
standards: the approved IEEE 802.16e
OFDMA standard, plus an additional
proposed standard (Corrigendum 1,
Draft 2), useful for troubleshooting
systems developed earlier. There are 3
pre-set profiles to choose from: 5 MHz,
10 MHz, and WiBro. To examine our
current signal, i80216e_DLPuscUni-
formQ64.sdf, select the 10 MHz profile.

5t 802.16 OFDMA Demodulation Properties

i tl Zone Definitiun] Time] Advanced]
Standard:
|IEEE 802.16e OFDMA |

Frame
Bandwidth

i Standard |10 MHz -

" Manual

Subframe

 Uplink.
@ Downlink

o Manual

Guard Interval:
« 1/8

" Other

Frame Length: W
Downlink Ratio: |50 %

Preset to Standard...

f¢ Use Preamble Index: |0

Subchannel Group Bitmask
VOWi1W2Ww3IWV4WE5E

For this measurement we want to use
the “uniform zone analysis” mode and
not “data burst analysis.” Note that
the current definition of the standard
preset does select the data burst
analysis mode. This setting needs

to be changed, and you can do this

by clearing the Data Burst Analysis
box on the Zone Definition tab of the
Demod Properties dialog box. On the
right side of the Format tab, select the
appropriate subframe, either Uplink or
Downlink. Note that this section of the
application note describes a downlink
measurement.

————

= & &

Close v Keep Open

Help

Figure 8. The Format tab of the Demodulation Properties dialog
box is where the IEEE 802.16e standard and the main

demodulation properties are selected.
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Basic Digital Demodulation (continued)

The next step is to confirm or change
the parameters on the left side of the
Format tab associated with the analyz-
er’'s sampling of the signal. Choosing
the Preset to Standard > 802.16e:

10 MHz automatically defaulted to
the correct values for Bandwidth, BW
Ratio, and FFT Size. You may choose
values other than the standard values
by selecting the Manual box on the
Format tab.

The FFT size associated with the

10 MHz nominal bandwidth signal

is 1024, yielding 840 active OFDM
carriers during the data portion of the
burst. Since carrier spacing is held
constant in IEEE 802.16 OFDMA, a

20 MHz nominal bandwidth signal
would use an FFT size of 2048 and
1640 active carriers, while a 5 MHz
nominal bandwidth signal would use an
FFT size of 512 and 420 active carriers.

For uniform mode analysis, the mod-
ulation format is automatically de-
tected on a symbol-by-symbol basis.
With these parameters and default
measurement selections for a four-
trace display, the analyzer produces
a display such as Figure 9 from the
supplied example downlink recording
i80216e_DLPuscUniformQ64.sdf.
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Figure 9. Demodulation results from a uniform downlink signal using only 640AM
modulation. The uniform appearance of the error vector spectrum display in the upper
right indicates that all OFDM subcarriers or logical subchannels are occupied.
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Basic Digital Demodulation (continued)

One of the most useful symmetries

in the display and analysis of OFDMA
signals is between the error vector
spectrum (error vs. frequency

or subcarrier) measurement and the
error vector time (error vs. time or
symbol) measurement. These mea-
surements are complementary and
orthogonal, and can be valuable both
for ensuring correct measurement

and for signal verification or trouble-
shooting. Accordingly, it is frequently
useful to have both measurements in
the same display, and that is easily
accomplished by selecting trace B
(merely click anywhere on the desired
trace), double-clicking the Trace Data
label at the upper left of the trace, and
selecting Error Vector Time from the
(alphabetized) list in the resulting dia-
log box. The error vector time trace can
then be autoscaled by right clicking the
trace and selecting Y Auto Scale. Now
you can simultaneously evaluate the
signal error in the time and frequency
domains. Using the mouse and the
marker tool (the small diamond) in the
toolbar, you can activate and place a
marker in any desired trace. You can
use markers on all of the traces (and
associated domains) and couple mark-
ers between them. To do this, select
Couple Markers from the Markers

menu and choose the marker location
by selecting it in the trace which is cur-
rently active. The markers in all other
traces will be shifted accordingly. An
example result is shown in Figure 10.

As shown in the figure, a symboal, such
as one associated with an error peak,
can be chosen from a desired domain
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(time, frequency, I/Q constellation
location, etc.) and examined in multiple
domains at once as a way to determine
its cause or significance. Errors may be
associated with a specific symbol value
(as determined from the symbol table),
with a specific time (or symbol), or with
a specific frequency (or subcarrier).

10

kR Cilo il M1 B
C: Ch1 OFDM Err Vect Spectium -10 dBm
5] | |
I |
o i
| |
LinMag[ .
5 i
e s
One Al & )
EE ST dg i
Start: -420 carier Stop: 420 carrier
RBW!: 10.9375 kHz TimeLen: 20 Sym
D: Ch1 OFDM Spms/Enrs Range: -10 dBm
RCE[EYM] = -41.255 dB
RCE[E¥M]) = 86547  mZms
RCE Pk = 3.8476 % pk at sym 10
DataRCE = -40.844 dB
DataRCE =907.33 m¥ms
DataRCE Pk = 3.2420 % pk at sym 10
7952 00 100
7968 [ oo
10 s=sym 1.23%¢2 -435.8382
_0 carrier 3.8476 2732 ||
3.847¢ .1282
sym 1]

Figure 10. Demodulation results showing error in both the time (lower left) and
frequency (upper right) domain. Coupling markers together on all traces lets you “walk”
through the signal and investigate anomalies. For instance, in this measurement, the
peak in the error vector time trace is associated with one of the BPSK pilots.
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Basic Digital Demodulation (continued)

In some troubleshooting applications on
complex pulsed or bursted signals such
as these, it can be helpful to simultane-
ously see both demodulated information
and spectrum or time domain informa-
tion. Where there is sufficient display
space, you can use the 6 trace display
mode of the 89600 VSA by selecting
Display > Layout from the menus or by
clicking the drop-down list to the right
of the trace buttons in the toolbar. 3 x 2
or 2 x 3 configurations can be select-

ed as desired, and the additional two
traces can be used to good advantage
to show both the spectrum of the signal
and RF envelope of the signal bursts

used for the pulse search operation (Cht
Search Time). An example is shown in
Figure 11.

In particular, the use of the search time
display is useful for diagnosing con-
sistent or intermittent demodulation
failures on pulsed/bursted signals. The
search time result should always include
at least one full RF burst (subframe) in-
cluding the rising and falling edges. You
can use the search time display with the
numeric figures and graphics provided
in the Time tab of the Demod Properties
dialog box, as will be described in a
later section of this note.

ﬂ Keysight 89600 Vector Signal Analyzer
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Figure 11. A 6-trace display lets you see even more information, including search time,
which is useful when troubleshooting pulsed or bursted signals. Normally, a 6-trace
display would be used with a much larger display than in this example and would
include additional annotations and marker data.
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Basic Digital Demodulation (continued)

If a specific demodulation format is de-
sired in a uniform zone measurement,
and you do not want the analyzer’s
automatic format detection, you can
manually set the Data Tone Modulation
by switching Data Tone Modulation to
Manual on the Advanced tab of Demod
Properties, as described in the 89600
Help. As might be expected, select-
ing the wrong type of modulation (a
mismatch to the actual modulation
type used in the signal) will cause

high errors in the time and frequency
domains, though the demodulation will
“lock” properly due to the presence

of the BPSK pilots. An example result
of 64QAM demodulated as QPSK is
shown in Figure 12.

l‘j_'i Keysight 89600 Vector Signal Analyzer

The data tone selection operates
somewhat differently in data burst
analysis mode than it does in the
uniform zone analysis mode described
here, and those differences will be
described during a discussion of data
burst analysis later in this note.
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Figure 12. Forcing QPSK demodulation of a 64QAM signal produces a large error (none
of the detected symbols is actually within the displayed QPSK targets), though the
demodulation locks successfully due to the presence of the BPSK pilots. The Y-axis
scaling has been changed from previous measurements.
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Basic Digital Demodulation (continued)

Downlink modulation quality
measurements of a burst
(nonuniform) signal

The next discussion of digital demodu-
lation of a downlink signal will use the
example downlink recording i80216e_
DL10MHz.sdf, supplied with the 89600
VSA software.

Prior to recalling any signal, it is a good
idea to use File > Preset > Preset Setup
to place the analyzer in a known state.

This new signal contains two zones
(i.e., it is not a uniform signal) and is
23 symbol times in length. The first
zone is PUSC and has an FCH (frame
control header), DL-MAP, UL-MAP,
and three data bursts: one each of
QPSK, 16QAM, and 64QAM. It occupies
12 symbols, though no data bursts
occupy the last 4 symbols. The second
zone is FUSC and contains three data
bursts: one each of QPSK, 16QAM,
and 64QAM. They occupy the first 4

symbols of the 10 symbol FUSC zone,
leaving the last 6 symbols unoccupied.
Note that you can see any of these
unoccupied symbols on the time trace.
The total downlink subframe is then 22
symbols plus the preamble.

This discussion will describe data burst
analysis, using the Zone Definition Map
file supplied with the signal recording
as part of the normal 89600 VSA soft-
ware installation.

Remember, from our previous discus-
sion, that it is generally helpful to make
vector (time envelope and spectrum or
gated spectrum) measurements on a
signal before setting up to perform dig-
ital demodulation. Once successfully
completed, you can continue with more
confidence.

As with the previous measurement,
digital demodulation begins with
selection of the digital demodulation
mode in the 89600 VSA and use of the

Preset to Standard » 802.16e: 10 MHz
in the Demod Properties dialog box’s
Format tab. In this case we want to
perform data burst analysis, so we will
not change the results of the preset
operation in this area.

The selection of the Downlink Sub-
frame and the Preset to Standard
operation on the Format tab causes
the synchronization to fail with this
example signal because it uses a
nonzero preamble index. Changing the
Use Preamble Index to 14 (which can
be determined by experimentation with
different values) will correct this. Note
that the SyncCorr value on the Syms/
Errs table changes from 0.04 to 0.98
after correcting this value. After this
setup you will be measuring only the
FCH (frame control header) data burst.
Without using a map file or otherwise
defining data bursts, the only burst
whose modulation and location is
known (by the analyzer, from the stan-
dard) is the FCH.



Basic Digital Demodulation (continued)

You can verify this by examining the
constellation display, where only QPSK
and BPSK modulation are present.
Note that in the default color coding
configuration for the 89600 VSA, the
BPSK pilot symbols are shown in white
(the default has been changed here for
clarity in monochrome printing), and
the QPSK FCH symbols are shown in
pink as in Figure 13.
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Figure 13. Measurement of a downlink PUSC signal. As indicated by the constellation
display and color-coding, this measurement only includes the BPSK pilots and the
QPSK FCH. The color coding of the data bursts is consistent across all traces.
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Basic Digital Demodulation (continued)

OFDMA Signal Maps

The IEEE 802.16 OFDMA signal structure is very complex. The analyzer setup
must match the setup of the transmitted signal. There are three ways to do
this in the analyzer.

The first, and easiest, is to recall a Keysight N7615A Signal Studio for 802.16
OFDMA setup file. To do this, simply go to the 89600 VSA tool bar and select
File > Recall > Recall Signal Studio Setup. This provides the analyzer with

a zone definition map matching the signal created with the N7615A Signal
Studio for 802.16 OFDMA. Thus, you only need to create the signal

definition once.

The second way is to use the Zone Definition Grid. The Zone Definition Grid is
a dynamic graphical user interface used to create uplink and downlink zone
definitions. You specify the data burst signal characteristics (name, data tone
modulation, symbol length/offset, etc.) and then use the mouse to map the
data burst region within the zone area of the Zone Definition Grid. When you
have defined all the data bursts for the zone, you can save the completed
zone definition to a map file.

The third way is to use a Map File. A Map File contains zone definitions in a file
(.omf extension) to simplify making measurements of frequently used signals.

You can Create, Edit, Delete, Export, and Import map files. Map files can save
very complicated OFDMA frame analysis zone definitions, which make them

a time-saving and accurate method to repeat a measurement. Also, map files

are ideal for recreating the identical measurement made by other users.
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Basic Digital Demodulation (continued)

Next, select the Zone Definition tab of
the Demodulation Properties dialog
box. The default Zone Definition Grid
map is shown at the bottom of this
tab; only the FCH data burst has been
defined. Other data bursts could be
defined manually (this will be discussed
in a later section of this note), but for
this measurement we will use a zone
definition map file that has already
been constructed for this recording.
This user map file is attached to a
setup file provided with the 89600
software in the same location as the
recorded signal. To access it, recall
the setup file i80216e_T10MHz.set. To
use this map file it is only necessary to
select the Use Map File box. An entry
field and drop-down list in this area will
show only <none> and i80216e_10MHz
(from setup) as map file choices unless
others have been defined.

The map file shows logical subchannels
on the Y axis and OFDM symbols on
the X axis. In addition to the FCH, 3
data bursts are defined and color-cod-
ed as shown in Figure 14.

¥ 802.16 OFDMA Demodulation Properties

Fomat £ ime| Advanced|
[V Use Map File

Current Name: | i80216e_10MHz (from setup)

w| EdtMapFies...

; : Use Defined
Selected Zone: v DataBurst Analysis [V Boasiig | avas
Name | Type | Name ] Mod Type ] Boost |—A
&) Zone# PUSC || Burstthl <AUTO>  0dB
& Zonett! FUsC || Bursth2 <AUTO>  0OdB
1 Burst#3 <AUTO> 0B
| = e e
| T il
1 Symbol Index ) 12

2!

Close v Keep Open Help

Figure 14. This Zone Definition Grid map was provided by a user
map file. The color-coding of the bursts in this map will appear
in all the bursts’ measurement and error displays.



Basic Digital Demodulation (continued)

After selecting the map file, the default
is for display and analysis of all data
bursts in the map. This means that all
measurement displays and the error
statistics summary table reflect the
composite of all the data bursts in the
map. This can be seen graphically in
the constellation trace of Figure 15,
where BPSK (pilots), QPSK, 16QAM
and 64QAM constellations are overlaid,
along with small circles as targets for
the symbol states. Note that the color
coding for data bursts is consistent
between the Zone Definition Grid map
and all of the analyzer displays.
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Figure 15. Using the example downlink map file (recalled as part of the setup file
provided) causes all data bursts to be measured and displayed. Note the display of
multiple simultaneous modulation types in the constellation diagram.
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Data burst analysis can be used to
display and analyze single data bursts
or selected groups. To select a specific
data burst, click the Zone Definition
Grid, or click the Burst name in the list
box above the map. The list box shows
the burst name, modulation type, and
boost level. After selecting a data burst
for analysis, you will see the analyzer
displays change to reflect the measured
characteristics and data of the selected
burst. The displays will generally be up-
dated immediately after you make these
changes, and it will not be necessary

to acquire new data. For bursts such

as these, where the modulation format
is different for each one, the easiest
way to see the change is to watch the
constellation display.

To select and measure multiple data
bursts at once, press the Ctrl key while
clicking the desired data bursts. To se-
lect all data bursts, right-click the Data
Burst list box or the Zone Definition
Grid, and click Select All.

One diagnostic clue for the proper
configuration of a transmitter, or of the
Zone Definition Grid map in the analyz-
er, is the absence of symbols at the cen-
ter or origin of the constellation when
measuring downlink signals. Symbols in
this location indicate that the analyzer
is expecting a modulated subcarrier at
a frequency where it is receiving little
or no signal energy. This phenomenon
indicates that one or more data bursts
are configured to expect logical sub-
channels or individual subcarriers which
are not being transmitted. You can
diagnose the specifics by coupling the
analyzer’'s markers, setting the marker
on one or more of the center constella-
tion symbols, and determining whether
the symbols are all associated with
subcarriers which can be identified with
specific logical subchannels.



36 | Keysight | IEEE 802.16e WiMAX OFDMA Signal Measurements and Troubleshooting - Application Note

Basic Digital Demodulation (continued)

Uplink modulation quality
measurements of a uniform
signal

This example of uplink analysis will use
the example uplink recording i80216e_
ULPuscUniform Q64.sdf, supplied with
the 89600 VSA software. Again, before
recalling this signal, it is a good idea to
perform a Preset > Preset Setup. This
uniform signal occupies all of the slots
in the zone, which means that all of
the OFDM subcarriers are active and
modulated with same type of modu-
lation (except for the pilots, which are

lﬁ Keysight 89600 Vector Signal Analyzer

modulated with BPSK). Using the vec-
tor measurement techniques described
earlier in this note, we can see that the
subframe in this recording is 24 OFDM
symbol times with approximately con-
stant power, and there is no preamble.
In IEEE 802.16 OFDMA, uplink signals
do not include preambles.

As with the previous measurement,
begin digital demodulation by select-
ing the OFDMA digital demodulation
mode in the 89600 VSA, and choose
the appropriate Uplink Subframe type
in the Demodulation Properties dialog
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Figure 16. A uniform 64QAM uplink PUSC signal incorrectly demodulated with the
default settings, (including the performance of data burst analysis). Note the difference
between the RCE (EVM) and UnmodRCE values in the Sym/Errs table.

box’s Format tab. Then use the Preset
to Standard function, also on the For-
mat tab. The result shown in a typical
4-trace digital demodulation display
after auto-scaling, is given in Figure 16.
While the constellation is clear, the er-
ror vector spectrum and the RCE figure
for the unmodulated carriers indicate
that the default digital demodulation
configuration is not entirely correct.

Fortunately, there are indications of a
way to correct the analyzer configu-
ration. First, the constellation shows
that carrier lock and symbol lock have
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been achieved. Second, the use of data
burst analysis (the default in the Preset
to Standard operation) is not needed
when analyzing a uniform signal. How-
ever, before we switch off data burst
analysis, it is useful to notice several
things about the constellation and the
Syms/Errs table. The constellation is
clearly locked to something, although
color-coding indicates a mixing of the
pilot and data locations. In addition,
the error vector time trace is very

high, while the numerical error data
(RCE) reported in the Syms/Errs table
is quite low — with one exception: the
UnmodRCE data (representing the RCE
of unmodulated carriers).

The reason for this result can be

seen by going to the Advanced tab

of Demod Properties. The analyzer’s
default settings for several parameters
are different for UL and DL signals. For
UL signals, the default is to include all
inactive subchannels in all traces. In
the Sym/Errs tabular data, the errors
are always broken out by carrier type:

Data RCE, Pilot RCE, and UnMod RCE.
By turning off Use Default Settings
and Include Inactive Subchannels on
the Advanced tab of the Demodulation
Properties tab, the trace error displays
appear maore congruent with the error
data values being displayed in the
Sym/Errs table.

You can adjust other parameters on
this tab as well, including directing

the analyzer to auto-detect modula-
tion format, or manually setting the
modulation format for uniform signals.
For burst signals, you can either let the
analyzer automatically detect the mod-
ulation format, or force it to use the
modulation formats described in the
burst definitions. Note that the analyz-
er will attempt to use these definitions
whether they are correct or not.

To correctly view this uniform signal,
however, we need to turn off Data
Burst Analysis. As before, the Zone
Definition tab on the OFDMA Demod-
ulation Properties dialog box is the
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place to deactivate Data Burst Analy-
sis. The analyzer defaults to automatic
detection of the 640Q0AM modulation
type. Since the analyzer typically is
able to update demodulation results
even when recording playback is in the
paused mode, the effect of the change
should be immediate. Example results
are shown in Figure 17, with error vec-
tor time and spectrum displays set to
0.1%/division.

ﬁ Keysight 89600 Vector Signal Analyzer

This signal is a digital simulation and
has virtually no error, and the demod-
ulation results are now correct. This
uniform uplink signal is a relatively
straightforward signal to analyze, as

it uses only one type of modulation

for the data carriers for a single data
burst, and does not include a preamble
or FCH.
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Figure 17. A uniform 64QAM uplink signal, correctly demodulated after Data Burst
Analysis is switched off. The analyzer automatically detects the single type of data

modulation.
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For the analyzer or a receiver, de-
modulating uplink subframes may be
a challenge for several reasons. First,
the lack of timing, frequency synchro-
nization, and equalization information
that might be provided by a preamble
requires more complicated synchro-
nization algorithms, with receivers
assuming specific pilot locations and
values. Second, settings for the frame
number index and the frame type
(PUSC, FUSC, etc.) must be correct to
provide the receiver with the accurate
pilot locations and values that are
essential for demodulation.

Incorrect frame numbers will not gen-
erally produce recognizable constel-
lations, though the constellations may
nonetheless exhibit some recognizable
digital modulation characteristics.

To help with UL synchronization the
89600 software will demodulate a
signal even if its PRBS is incorrect. The

recovered PRBS seed result is present-
ed on the Sym/Errs table. The user can
decompose this 11-bit Status value
into a Frame Number and IDCell for the
UL in order to confirm that the settings
match expectations. A small indica-
tor (“*”) is provided if the software
detects a mismatch between the PRBS
sequence and the setup, and yet a fur-
ther indicator (“?”) is presented if the
89600 software cannot uniquely iden-
tify the PRBS seed. This may indicate
an incorrect PRBS generator, or insuffi-
cient data to deduce the PRBS. Since
the PRBS determines the carrier and
pilot positions, a correct PRBS is vital
to even beginning measurements. This
unigque 89600 VSA software capability
can help you troubleshoot your early
development efforts and get a working
design as quickly as possible.
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Uplink modulation quality
measurements of a burst
(nonuniform) signal

The next discussion of digital demod-
ulation of an uplink signal will use the
example uplink recording i80216e_UL-
10MHz.sdf supplied with the 89600
VSA software. This example will
describe data burst analysis, though
analysis is simpler on the uplink signals
due to the presence of a single data
burst in this signal.

We will use the same setup file

used earlier for downlink analysis:
i80216e_10MHz.set. Again, prior to
recalling the signal and its setup file,
you should Preset Setup to avoid
having previous settings contaminate
the new setup. After recalling the
i80216e_10MHz.set setup file, choose
the appropriate Uplink subframe type

ﬁ Keysight 89600 Yector Signal Analyzer

in the OFDMA Demodulation Proper-
ties dialog box’s Format tab. Changing
trace B from spectrum to error vector
time produces a display similar to that
of Figure 18.

After switching to the uplink subframe
type, the analyzer has defaulted to
measurement of the first zone of the
subframe; a PUSC zone. The analyzer
is automatically detecting the modula-
tion type of the single data burst in this
zone, as shown by the Zone Definition
tab. Also on the Zone Definition tab,
you can see the Zone Definition Grid
which shows that the data burstisin
“wrapped format” covering the first

15 symbols of the subframe and does
not use all of the logical subchannels.
Therefore, many of the OFDM subcar-
riers are not used for this burst and
could be used for other bursts.
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Figure 18. Demodulation of the PUSC zone of a 16QAM uplink signal. The constellation
diagram also includes the BPSK pilots and a central symbol target for subcarriers not

used by the mobile station.

In the constellation display of Figure
18, the signal (or lack of signal) from
the unused subcarriers is shown by
symbol states and a symbol target at
the center of the constellation dia-
gram. Indeed, the ideal location for the
symbols associated with unused OFDM
subcarriers is the exact center of the
constellation diagram, signifying that
no power is transmitted on these un-
used subcarriers and their associated
logical subchannels. Power transmitted
on these subchannels would tend to
interfere with reception of intended
transmissions on these frequencies

by other mobile stations, especially in
unfavorable near/far configurations of
transmitters and receivers. In uplink
measurements, the 89600 VSA de-
faults to a measurement of EVM which
includes the contribution of unused
subchannels. The 89600 VSA automat-
ically reports RCE (EVM) of unmodu-
lated carriers in its Syms/Errs table.
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Basic Digital Demodulation (continued)

This is in some ways similar to a noise
power ratio measurement or code
domain error. Where it is desirable to
view only the active subchannels asso-
ciated with the selected data burst, the
display configuration can be changed
by clearing a box on the Advanced tab
of the OFDMA Demodulation Proper-
ties dialog box labeled Include Inactive
Subchannels in EVM.

This signal contains two zones: 15
symbols of PUSC, and 6 symbols of
OPUSC. Measuring the OPUSC zone
is slightly more complex because the
analyzer expects the OPUSC zone

to be located at the trigger location
chosen by the pulse search algorithm.
Instead, the PUSC zone begins at that
time. So, to measure the OPUSC zone
the analyzer must be set to skip the
first 15 symbols of the PUSC zone. To
do so, go to the Time tab of OFDMA
Demodulation Properties and select
Manual Sync Search, with an Offset of

15 symbols. Then switch back to the
Zone Definition tab and click Zone#1,
the OPUSC zone in the list of selected
zones. The analyzer will now use its
pulse search algorithms to locate the
RF burst, and then delay 15 symbols to
begin the analysis of the OPUSC zone,
as shown in Figure 19.
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Figure 19. Measurement of the 6 symbols of the second (OPUSC) zone of the same

uplink signal as used previously in Figure 18.
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Common problems and
troubleshooting approaches
for “uniform” measurements

Both the IEEE 802.16 OFDMA standard
and the signal itself are quite complex
from an RF physical layer standpoint
(RF bursting, multiple carriers, moving
pilots, multiple modulation types, etc.)
and from a baseband digital stand-
point (preamble indexes, subchannel
bitmasks, permutation functions, etc.).
There are, therefore, many possible
causes of demodulation failure includ-
ing uncertainty and confusion over the
correct interpretation of the standard
itself. As an aid to troubleshooting, the
following are some typical demodula-
tion results, along with suggestions as
to possible causes.

Low “Sync Corr” (sync correlation; see
the table in the Syms/Errs trace data
type) value and possible demodulation
failure. An incorrect preamble value on
downlink signals may be the cause. The
preamble index may be incorrect, or
may be selected based on a different
interpretation of the standard than that
of the 89600 VSA.

Circular symbol configuration when
phase tracking is turned on (see the Pi-
lot Tracking box on the Advanced tab):
BPSK symbols not colored as pilots
while QPSK/QAM symbols are. This

may be a problem with incorrect pilot
locations on a downlink signal, either
due to an incorrect offset value (on

the Zone Definition tab of the OFDMA
Demodulation Properties dialog box),
or the pilot location may be based on a
different interpretation of the standard
than that of the 89600 VSA.

Symbol constellations appear to have
a near-random “cloud” pattern. This
type of constellation on an uplink
signal suggests that the pilot symbols
were not detected for synchronization.
Causes are similar to the previous
phenomenon, including mismatched
setup parameters and differing inter-
pretations of the standard. Successful
demodulation may be possible by
experimenting with parameters such
as Offset and PermBase in the Zone
Definition tab to find a match with the
signal.

Noisy constellations with a large
symbol clock error (SymCIKErr, see the
table in the Syms/Errs trace data type),
or unlocked measurements. These phe-
nomena may be caused by incorrect
values of the Bandwidth (or Nominal
BW if set manually) value in the Format
tab of the OFDMA Demodulation Prop-
erties dialog box. The bandwidth value
determines OFDM carrier spacing, and
it should be set as closely as possible
to the actual value. Subcarrier mea-

surements such as those described in
the time and frequency (vector) domain
section earlier in this application note
may be helpful in determining the
exact subcarrier spacing and the actual
bandwidth of a specific signal.

Pulse search failure. A variety of condi-
tions may cause this error enunciator to
appear (typically along with demodula-
tion failure). You can disable the pulse
search function in digital demodulation
and configure a trigger as a substitute.
The trigger may be internally gener-
ated using an IF magnitude value and
appropriate holdoff and delay values,
or external triggers may also be used if
available.
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Common problems

and troubleshooting
approaches for “data burst”
measurements

The suggestions above for uniform
measurements are also applicable to
data burst measurements. In addi-
tion, the following approaches may be
helpful.

Unexpected modulation formats (or
noise) appear in the constellation
where other modulation formats are
expected. Incorrect permutation
parameters on downlink signals may
be causing zone parameters to be

mismatched or the parameters may be

based on a different interpretation of
the standard than that of the 89600
VSA. The PRBS Status on the Syms/
Errs table can provide information on
what was actually decoded, including
such parameters as the PRBS seed,

ID cell, segment, PermBase, PRBS_ID,

and much more. In addition, it may
be helpful to try the P802.16 OFDMA
(Cor1/D2) standard mode, selected
from the Format tab in the OFDMA
Demodulation Properties dialog box.

Symbol constellations appear to have

a near-random “cloud” pattern. This
type of constellation on an uplink
signal suggests that the pilot symbols
were not detected for synchroniza-
tion. Causes are similar to those for

the uniform measurements, including
mismatched setup parameters and dif-
fering interpretations of the standard.
Successful demodulation may be pos-
sible by experimenting with parameters
such as Offset and PermBase in the
Zone Definition tab to find a match with
the signal. This situation is essentially
similar to the uniform measurement
mode measurements performed on
uplink signals, as described previously.
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The last step in our measurement and
troubleshooting sequence is the most
powerful for finding and measuring
problems that are either subtle or are
more complex than those discussed
so far.

The analyzer provides a variety of spe-
cialized demodulation configurations
for more advanced analysis, including
demodulation of specific portions of
the signal and adjustment of many
different demodulation parameters.

Some of these analysis techniques take
advantage of specific characteristics

of the OFDMA signal, including the
built-in equalization training sequences
and pilot carriers. Some other types of
more advanced signal analysis primar-

ily involve display and measurement
types particularly relevant to these
OFDMA signals, such as the data burst
information table and channel fre-
qguency response adjacent difference

display.

Table 5. Advanced demodulation operations provide more sophisticated and specific measures of signal

characteristics and impairments.

Frequency,

frequency and >
time

Basic
digital demod

Advanced and
specific demod

Get basics right, find major
problems

Signal quality numbers,
constellation, basic error
vector measurements

Find specific problems and

causes

- Demod by carrier or
symbol or both

- Select pilot tracking
types

— Select carrier,
timing

- Preamble (equaliza-
tion) analysis

- Cross-domain and
cross-measurement
links

- Demod parameter
adjustments

- More time capture
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Advanced displays

Equalization and channel
frequency response

As shown previously in both vector and
basic digital demodulation measure-
ments, downlink subframes include

a preamble with a time length of one
OFDM symbol. The preamble is com-
posed of every third OFDM subcarrier,
with one each transmitted at equal
amplitude. In addition to its use by
subscriber unit receivers, this preamble
is very useful for diagnostics by the
89600 VSA.

Adaptive equalization is required by the
WIMAX standards and is normally used
to compensate for linear errors such as
amplitude and phase flatness, either

in the transmitters or in the transmit
channel. When measured directly at
the output of a transmitter, typical
causes of error include baseband or IF
filtering errors, and incorrect sin(x)/x
compensation.

These errors may be caused by mul-
tipath or by tilt or ripple in the frequen-

cy response of a system. In contrast,
noise, intermodulation, and the effects
of amplifier compression are nonlinear
forms of distortion, and are not cor-
rected by adaptive equalization.

Similar to the receiver in a subscriber
unit, the 89600 VSA uses the preamble
to calculate coefficients for its adaptive
equalizer, and these filter coefficients
are very useful for troubleshooting.

In addition, (in contrast to the typical
subscriber unit receiver) the 89600
VSA software allows the adaptive
equalizer to be trained on either the
preamble or on the entire subframe,
including the preamble. Including

both the preamble (also called the
channel estimation sequence) and the
subframe data improves the channel
equalization estimate, and is called
data-driven equalization. The improved
channel equalization estimate has the
dual benefits of typically more accu-
rate modulation quality results and a
more accurate estimate of the channel
frequency response for display and
analysis.
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For the design engineer, a major ben-
efit of equalization is that the results
can be viewed, quantified, and then
used to find the source of problems.
Using the same nonuniform downlink
PUSC signal (i80216e_DL10MHz.sdf)
as in previous digital demodulation
measurements, you can configure
the analyzer to show the equalization
results in a variety of different ways as
shown in Figure 20.

The equalization results are shown in
several different forms in this figure.
The equalizer channel frequency
response in log magnitude form (trace
B) is perhaps the most familiar. This

is the combined amplitude frequency
response of the channel and the trans-
mitter, displayed against the OFDM
carrier frequency number. The frequen-
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cy response can be displayed in terms
of phase as well, as shown in trace C,
where phase is selected as the data
format. The analyzer can also display
the impulse (time domain) response
of the filter it created to equalize the
channel, and this is shown in trace

D, labeled OFDM Eqg Impls Resp. This
impulse response result may be more
useful than frequency response in
some DSP design efforts.

As mentioned previously, the analyzer’s
equalizer can be trained on the pre-
amble (channel estimation sequence)
or on the entire subframe including
both the preamble and the data, or

on the channel estimation plus pilots.
Since an uplink signal has no pream-
ble, the analyzer uses either the pilots
or a combination of data and pilots,
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Figure 20. Channel frequency response amplitude (lower left) and phase (upper right)
and equalizer impulse response (lower right) derived from adaptive equalizer trained on

downlink preamble.

depending on which Equalizer Training
parameter is selected. This training
choice is available as check boxes

on the Advanced tab of the OFDMA
Demodulation Properties dialog box,
and may result in significantly different
modulation quality results, depending
on the specific signal involved. Since
the signal recording used as an exam-
ple here is of high quality and does not
have significant multipath, the effect
of the change in equalizer training is
to change the measured modulation
quality (RCE/EVM) from approximately
-49 dB to -52 dB depending on which
mode is chosen, though all indicate
very low levels of error. The effect on
the equalizer display traces is corre-
spondingly slight.
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Advanced Digital Demodulation (continued)

Channel frequency response
adjacent difference

Analyzer equalization results can be
displayed in a variety of ways. Where
the specific interest is in the amount
of subcarrier-to-subcarrier (or equiv-
alently, FFT bin-to-FFT bin) variation,
the ChFreqRespAd] Diff trace will be
useful. This trace is derived from the
adaptive equalizer’s channel frequency
response trace and therefore is affect-
ed by the choice of equalizer training
data as described above.

Example results of this trace type are
shown in the three traces in Figure 21,

Iﬁ Keysight 89600 Yector Signal Analyzer

using the same downlink recording as
was used previously for the equaliza-
tion discussion.

For this measurement, the adjacent
difference results are shown in several
ways. The top trace is the result of
using only the preamble (channel esti-
mation sequence) to train the equaliz-
er. Accordingly, information is available
for only every third OFDM subcarrier.
Using the entire data portion of the
subframe adds to both the information
input and output of the equalization
algorithm, as shown by the improved
frequency resolution of the middle
trace.
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Figure 21. Channel frequency response adjacent difference measurements. Trace A
results are calculated from the preamble only. Trace B results are calculated from the
entire subframe, and trace C results are calculated from channel estimation sequence

and data for data burst 3 only.

The adjacent difference results are also
affected by the selection of data bursts
for analysis. Where data bursts do

not include the use of specific OFDM
subcarriers, the analyzer interpolates
between known data points in creating
the display. This is shown in the lower
trace of Figure 21 where only burst 3
of the downlink subframe is analyzed.
This burst uses 10 of the 30 logical
subchannels, resulting in a sparser
data set for the adjacent difference
calculations and the corresponding
results.



48 | Keysight | IEEE 802.16e WiMAX OFDMA Signal Measurements and Troubleshooting - Application Note
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Data burst information table FCH. Reported values for each data

A new display associated with [EEE burst include the format, the burst
802.16 OFDMA measurements in the size (length), average power, and the
89600 VSA is the OFDM Data Burst average error (RCE, in dB) of the entire
Info table. This is both a measurement  signal or the data subcarriers only
data type and an associated display (DataRCE).

format. Example results from the non-
uniform downlink PUSC recording are Like the rest of the displays available

shown in Figure 22. when in data burst analysis mode, this
table reflects only the results of the
This display is used when in the data data bursts selected for analysis.

burst analysis mode, and is most useful
when you are measuring multiple

data bursts. It provides a list of the
subframe’s data bursts, including the

T2 Keysight 89600 Vector Signal Analyzer - Press ESC for ... [2 |[E][%)

A; Chl OFDM Data Burst Info Fange; 100 my
DataBurst  ModFmt  Sizefslots] Pwr(dB] RCE[dB] DataRCE[dE]
<FCH> QPSK 4 -0.00614 -50.048 -50.048
<DL MAP:>QPSK 26 -0.00125 -51.003 -51.003
<UL MAP:>QPSK 20 -0.00059 -50.826 -50.826
Burstiit GPSK 24 -0.00262 -51.043 -51.043
Burstif2 160aM 24 -0.04636 -50.853 -50.853
Burstif3 B40AM 16 -0.05139 -50.896 -50.896

Figure 22. The Data Burst Info trace lists the FCH and all
measured data bursts in the subframe, along with their
size, power, RCE, and the RCE of selected data bursts (if
display space permits).
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Pilot tracking

In much the same way as for IEEE
802.17a OFDM and IEEE 802.16-2004
WIMAX, IEEE 802.16 OFDMA demod-
ulation is performed relative to BPSK
pilot carriers which are embedded in
the signal. These pilot carriers replace
data-carrying elements of the signal
and allow many impairments to be
dynamically removed or “tracked out.”
The pilot carriers are transmitted con-
tinuously throughout the data portion
of the subframes, though their location
varies according to permutation
functions. The pilots for some logical
subchannels will not be present for
every symbol of every data burst.

Many signal impairments will be com-
mon to all pilot carriers, and can be
measured and displayed as “common
pilot error.” This parameter is reported
as part of the Symbols/Errors trace
data.

In addition, the specific tracking func-
tions can be individually switched on
and off in the demodulation performed
by the 89600 software. This is a very
useful troubleshooting approach, since
modulation errors can be examined
with and without the benefit of partic-
ular types of pilot tracking.

Three types of tracking are avail-
able: Amplitude, Phase, and Timing.
Selection of tracking parameters is
accomplished on the Advanced tab of
the OFDMA Demodulation Properties
dialog box (after clearing the box for
Use Default Settings), as shown in
Figure 23.

Amplitude tracking (default for the
89600 VSA is Track Amplitude Off for
downlink signals and On for uplink

signals). A common type of signal
impairment is varying signal amplitude
during a subframe. Signal changes
such as variable subcarrier occupancy
and modulation type over different
data bursts can cause RF and micro-
wave circuits to change temperature
and gain during a subframe. For sub-
scriber units, the combination of trans-
mit and DSP power may cause ampli-
tude droop. When Track Amplitude is
selected, the tracking results can be
analyzed by viewing the magnitude
portion of the Common Pilot Error data
type. Such errors could be isolated by
comparing the peak error symbols with
their location in the constellation and/
or their location in the subframe.

¥ 802.16 OFDMA Demodulation Properties
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Fulmall Zone Definitiun] Time § 4

[V 12 Normalize [ Use Default Settings
Mirror Frequency [ Include inactive subchannels
Spectum Pilot Tracking:
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Symbol Timing Adjust:

3125 %

e Equalizer Training:

" Chan Estimation Seq Only
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=

Data Tone Modulation
&+ Automatic

" Manual  [see burst definitions)

Figure 23. Pilot tracking parameters including amplitude, phase,
and timing can be selected in any combination on the Advanced
tab of the OFDMA Demodulation Properties dialog box.
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Phase tracking (default for the 89600
VSA is Track Phase On). Operation is
similar to amplitude tracking, except
that the analyzer demodulation tracks
the phase of the pilot carriers. Close-in
phase noise, for example, can be re-
moved or tracked out by phase track-
ing. As with amplitude tracking, when
phase tracking is selected, the tracking
results can be analyzed by viewing the
phase portion of the Common Pilot
Error data type.

Timing (default for the 89600 VSA is
Track Timing Off for downlink signals
and On for uplink signals). When Track
Timing is selected, the analyzer applies
pilot subcarrier timing error correc-
tion (frequency offset correction) to
the pilot and data subcarriers. Timing
errors may be caused by oscillator
frequency errors or DSP errors such

as an improper number of samples in
the guard interval. It is useful to keep
in mind that both analog and digital
(DSP) mechanisms can cause timing
problems. DSP defects such as an
improper sample rate can also affect
relative timing in the subframe. One
useful troubleshooting technique is to
observe changes in common pilot error
when timing tracking is enabled.

Symbol timing adjustment

The alignment of the analyzer’s symbol
demodulation within the interval
defined by the OFDM symbol plus the
guard interval is adjustable through

a dialog box in the Advanced tab of
the OFDMA Demodulation Proper-

ties dialog box. For the 89600 VSA,
this positions in time the FFT used

for demodulation. No specific time
position is called out in the standard,
and different timing settings will affect
measured modulation quality. In par-
ticular, if filter ISI or multipath affects
the guard interval, certain symbol tim-
ing settings will provide much better
demodulation results than others.

Time-specific and frequency-
specific measurements

You can use a large variety of
time-specific (relative to time inter-
vals, symbols, frames, or triggers) and
frequency-specific (OFDM subcarriers
or logical subchannels) analysis con-
figurations to find problems and isolate
their causes. In [EEE 802.16 OFDMA,
many useful measurements are both
time-specific and frequency-specific,
as we will see in the examples that
follow.

These techniques can help, for exam-
ple, find subtle defects such as DSP
errors or impulsive interference that
only affect a specific carrier/frequency
at a specific time or over a specific time
interval.
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Customizing a Zone Definition
Grid map for measuring
individual data regions

The process for individually defining
zones or configuring a zone map for
data burst analysis can be best under-
stood by beginning with a known signal
and its associated map. We will use
the same example downlink recording
supplied with the 89600 VSA software
as was used previously for data burst
analysis: i80216e_DL10MHz.sdf. As be-
fore, remember to Preset Setup before
recalling this signal, and its associated
setup file i80216e_10MHz.set.

After recalling the setup file, data burst
analysis is enabled and all of the data
bursts are selected for measurement
and display. You can verify this by ex-
amining the Zone Definition Grid map
at the bottom of the Zone Definition
tab of the OFDMA Demodulation Prop-
erties dialog box and noting that the
outlines of all data bursts are flash-
ing. The zone definition map reveals
that the FCH data burst (upper left)

is composed of 4 logical subchannels
with a duration of 2 OFDM symbols.
An appropriate zone definition map file
for the other data bursts in this signal
has been provided with the analyzer’s
setup file, and you can select this by
selecting the Use Map File box (this
selection has already been performed
by the setup file).

At this point it is instructive to choose
a single data burst and modify its zone
map to see the measurement results in
the time and frequency domain (error
vector time and error vector spec-
trum). For this example, Zone #1 will
be modified since it does not contain a
preamble or UL/DL maps and is there-
fore simpler to edit. You can do this
graphically by clicking the Edit Map
Files, and then From Setup buttons to
bring up the OFDMA Map File Editor.
From the Downlink Zones section click
Zone #1 and the Edit button. This will
bring up a display of the zone T map,
which will look different from the zone
0 map that you may have already been
measuring. There you can delete data
burst #3 (64QAM, middle burst, typi-
cally colored green). Simply click any-
where in the burst to highlight it and
click the Delete Burst button. When
the burst is selected you can verify its
name and the type of modulation in
the Burst area at the upper right of the
display. Click OK and Close, as needed,
to return to the display of the OFDMA
Demodulation Properties dialog box.
Then, from the Selected Zone area of
the OFDMA Demodulation Properties
dialog box, click Zone #1 to select it for
analysis.



52 | Keysight | IEEE 802.16e WiMAX OFDMA Signal Measurements and Troubleshooting - Application Note

Advanced Digital Demodulation (continued)

Now, select only burst 2 for analysis by
clicking Burst #2 in the Data Burst List
on the OFDMA Demodulation Prop-
erties tab or by clicking anywhere in
the graphical representation of burst
2 on the Zone Definition Grid table at
the bottom of the dialog box. These
changes take effect immediately.

Note that only T6QAM modulation
now shows in the constellation display
(along with the BPSK pilots). Your
display should be similar to Figure

24, where traces B and C have been
changed to error vector time and error
vector spectrum, respectively.

You will see from the error vector time
display that only 4 symbols are being
analyzed, and from the error vector
spectrum display you will see that only
a portion of the OFDM subcarriers are
being used for the selected data burst.
The OFDM subcarrier population may
be viewed in greater detail by using
the Select Area marker tool (chosen
from the marker toolbar or by selecting
Markers > Tools > Select Area) and
X-axis scaling the error vector spec-
trum trace, focusing on perhaps the
center 20% of the trace, by drawing a
box and clicking Scale X. The trace can
be returned to full scale by selecting it
and then Trace > X Scale and clicking
Full Scale.
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Figure 24. Data burst measurement of a single burst from a downlink FUSC signal.
Burst 2, with 16QAM modulation has been chosen for analysis.

Of course if the goal of the measure-
ment was to analyze only burst 2 of
zone 1, these parameters could have
been selected directly from the OFD-
MA Demodulation Properties dialog
box without editing the zone map. The
technique described previously would
normally be used to manually define
zone maps to match the signal under
test or to experiment with unknown
signals to learn their structure.
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Advanced Digital Demodulation (continued)

The next step is to experiment with
re-defining the data burst to include
fewer logical sub-channels and/

or fewer symbols. Follow the same
procedure to again bring up the Edit
Downlink Zone Definition Map dialog
box: From the Zone Definition tab of
Demodulation Properties, click Edit
Map Files > Edit (with i80216e_10MHz
selected). Click Zone#1 in Downlink
Zones and click Edit, and then click
the zone map on burst #2 (the lower
burst). You will see that burst #2 is
highlighted and blinking, and occupies
six logical subchannels for a duration
of 4 symbols or 24 slots.

Use the mouse to click and drag
diagonally from corner to corner

to re-define burst 2 by creating a
rectangular region with a “height” of
one logical subchannel and a length
of 3 symbols, anywhere within the
previous boundaries of burst 2. Click
OK and Close, as needed, to return to
the display of the OFDMA Demodula-
tion Properties dialog box, selecting
Yes when asked if you want to reload
i80216e_10MHz. Click burst 2 to select
only the newly-defined burst for anal-
ysis. Note the differences in the error
vector time and error vector spectrum
traces. The measured result in time is
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Figure 25. Data burst analysis of a portion of the original burst 2. The error vector time
(lower left) trace shows that only 3 symbols are measured, and the error vector
spectrum (upper right) shows the sparse OFDM subcarrier population representing the
one measured logical subchannel.

now 3 symbols long, and the OFDM
subcarrier population (representing

a single logical subcarrier) is much
more sparse. Since all the subcarriers
now defined for this burst are actively
modulated with the right format for the
selected duration of the new burst, the
error parameters should all be low, as
shown in Figure 25.
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Advanced Digital Demodulation (continued)

Now we can observe the result when
burst 2 is defined with logical chan-
nels beyond those actually transmit-
ted, and/or with a burst length which
includes a combination of symbols and
subchannels where inactive subcarriers
are analyzed. For example, extending
the time duration of burst 2 (beyond
that previously defined) to cover 3 ad-
ditional symbols in this zone will cause
some inactive subcarriers (the equiv-
alent of noise) to be demodulated as
16QAM data. Similarly, expanding burst
2 into logical subchannels previously
defined as 64QAM (from the deleted
burst 3) will cause these symbols to be
demodulated as 16QAM instead. The
resulting zone definition grid is shown
in Figure 26, and the corresponding
measurement results are shown in
Figure 27.
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Figure 26. This zone definition grid has been modified to explore the effects of incorrect
data burst length and demodulation type (16QAM instead of 64QAM). The demodulation
results are shown in Figure 27.
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Figure 27. Incorrectly defining the zone map for data burst analysis causes large errors
where 64QAM (from an adjacent burst) is demodulated as 16QAM, and symbols for
inactive carriers are shown at the center of the constellation diagram.
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Advanced Digital Demodulation (continued)

Several results in all of the analyzer
displays are useful for troubleshooting
the kind of problems introduced in this
example. The constellation display now
includes a number of 64QAM sym-
bols without targets in addition to the
expected T6QAM symbols and targets.
The 64QAM symbols will be analyzed
as 16QAM, resulting in much higher
error figures. There are also symbols
(without a target) at the center of the
constellation diagram; this is a result
of demodulating parts of the zone
without active subcarriers.

The error vector time trace reveals
the same errors in a different way. The
average and peak errors climb sharp-
ly, starting at symbol 17, where data
transmission has actually stopped. A
related behavior is shown in the error
vector spectrum trace, where error is
either very high (64QAM or inactive
carriers demodulated as 16QAM) or
very low (16QAM demodulated proper-
ly and BPSK pilots).

You can edit, save, and recall these
zone maps, and customize the asso-
ciated data burst analysis to verify
the proper composition of a zone, or
to troubleshoot problems in the data
burst arrangement of a zone.

Note: The analyzer will remember

the (deliberately incorrect) zone map
which has been created here even
after analyzer Preset and Preset to
Standard actions, so it is a good idea
at this point to reset the map to the
correct values for this example down-
link signal. To do this, you will need to
delete this modified i80216e_10MHz
zone definition map file (these files
have the extension “.omf”) and recall
the original preset file. From the Zone
Definition tab click Edit Map Files,
select the i80216e_10MHz map file and
click Delete. Then recall the setup file
i80216e_10MHz.set and you will see
the zone definition map (for Zone 1)
return to the original configuration with
three data bursts.
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Advanced Digital Demodulation (continued)

Measuring specific time or
symbol intervals

Time-specific measurements are an
essential element of troubleshooting
any system using time-varying signals
such as pulsed/bursted transmissions,
TDMA techniques, variable power
levels or boosting, etc. For OFDMA,
demodulation of specific elements of a
subframe is a powerful troubleshooting
technique, allowing clearer isolation of
errors and impairments, and therefore
a clearer view of their causes. The
Time tab of the OFDMA Demodulation
Properties box in the 89600 VSA offers
several types of time-specific anal-
ysis within the digital demodulation
function. Compared with time-specific
vector mode analysis, the digital de-
modulation function offers significant
benefits in the areas of pulse and sync
searching, synchronization with frames
and subframes, and alignment of mea-
surements with OFDM symbol times.

In addition, the Time tab of the OFDMA
Demodulation Properties dialog box
includes a graphic display showing the

relative timing of the measurements vs.

the frame and zone timing.
For this example, we will use the same

downlink recording (i80216e_DL10M-
Hz.sdf) supplied with the 89600 VSA
software as used above for data burst
analysis and for customizing a zone
map. If you have not already done so,
use the instructions at the end of the
previous section to delete the modified
zone definition map file. As described
previously, perform the Preset Setup
function, recall the recording, and re-
call its setup file, i80216e_10MHz.set.

We will now use the recorded down-
link signal (containing a PUSC zone
followed by a FUSC zone) to explore
time-specific measurements. After
the signal and its setup file have been
recalled, select the appropriate zone
definition map file by selecting the Use
Map File box on the Zone Definition tab
of the OFDMA Demodulation Proper-
ties dialog box. It is also a good idea
to configure the analyzer for the same
combination of constellation, error
vector time, and error vector spec-
trum displays as used in the previous
examples. The analyzer should default
to measuring the first zone in the sub-
frame: Zone #0 (the FUSC zone).
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Advanced Digital Demodulation (continued)

For a time-specific measurement
relative to symbols in the subframe, it
is now only a matter of selecting the
Time tab of the OFDMA Demodulation
Properties dialog box. From the setup
file the analyzer should be configured
to select all of the data bursts for
analysis. If a single burst is selected,
the Manual Measurement Region (on
the Time tab) is limited to testing the
selected burst. The graphic diagrams
and entry areas of this tab are shown in
Figure 28.

Note the figures in the Timing Diagram
portion of the tab. The result length
and its relationship to the OFDM frame
are shown at the bottom, while the
analysis region is shown at the top. The
default is for analysis of the entire 12
symbol (1.234 mSec) data portion of
the subframe, following the zone offset
of 1 symbol due to the preamble.

You can perform a simple time-specific
analysis of the subframe by selecting
the Manual Measurement Region check
box and entering a measurement inter-
val of 4 symbols. With a measurement
offset of O symbols, the result will be

a measurement isolated to the first 4
symbols of the subframe, and a display
in the Time tab similar to Figure 29.
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Figure 28. The Time tab on the OFDMA Demodulation Properties
dialog box includes an active timing diagram (derived from the
signal and user settings, and updated as the measurement
configuration is changed) to help you visualize your signal for
easier measurement setup.
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Figure 29. After selecting a manual measurement region with
a length of 4 symbols and an offset of 0 symbols, the timing
diagram reflects the actual measurement interval and offsets
in seconds. This is a clear graphic representation of the
measurement interval of 411.4 pSec and its relationship to the
total result length, frame, and zone length (1.234 mSec).
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Advanced Digital Demodulation (continued)

The analyzer display will now reflect
only the first 4 symbols in the sub-
frame, and from the map file you can
see that these 4 symbols include the
FCH, UL Map, DL map, and a portion
of burst 1. Therefore, the only symbols
shown in the constellation are either
BPSK or QPSK. Close examination of
the QPSK color-coding indicates that
data from all four bursts are, in fact,
included.

Changing the Measurement Offset

to 4 symbols results in a measure-
ment of only the last 4 symbols in this
subframe and appropriate changes in
the timing diagram on the Time tab.
Note the Measurement Offset data in
the diagram of 411.4 uSec or exactly 4
OFDM symbols.

The Timing Diagram on the Time tab
now reflects the change in the time
interval used for calculation and dis-
play of measurement results. Figure 30
shows the resulting constellation and
OFDM Data Burst Info displays (trace
C has been switched to this trace data
type). Note that while all three bursts
and pilots are visible in the constel-
lation and Sym/Errs table, no FCH or
MAP data is included in the data burst
information table. That is because the
analyzer is skipping over the first 4
symbols which, according to the zone
map, are where the FCH, and the UL
and DL MAP data bursts exist.

The Manual Measurement Region
selection also includes additional
capability. For instance, the Pre-de-
mod Waveform and Include extra
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Figure 30. Manually selecting a measurement region (time interval) of 4 symbols with
an offset (delay) of 4 symbols produces a result which does not include the FCH,
DL-Map or UL-Map. The lack of information for these data bursts in the Data Burst Info
table reflects this measurement configuration.

time in pre-demod traces selections
affect the time-domain gating of the
signal, but only for pre-demod traces,
including Time, Spectrum, and CCDF.
This is useful for measuring character-
istics of regions which are adjacent to
the portion of the waveform used for
modulation analysis. You can find more
information on these and other se-
lections on the Time tab in the 89600
VSA's extensive Help text.
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Advanced Digital Demodulation (continued)

Measuring a specific
subcarrier or range of
subcarriers

Some modulation impairments, espe-
cially those involving interference of
some kind, are associated with spe-
cific frequencies or frequency ranges.
Indeed, one of the benefits of OFDM
techniques is their relative immunity
to narrowband interference or ro-
bustness of transmission capability in
environments where one frequency or
a particular band of frequencies (and
therefore subcarriers) is significantly
impaired.

The error vector spectrum display,

as described previously, can reveal
error behavior that is associated with
frequencies or subcarriers. Since the
number of subcarriers is so large (840
active subcarriers during data bursts
of the 10 MHz signal), X-axis display
scaling can be very useful for focusing
attention on the desired range of car-
riers. One application of this approach
would be to examine band edges more
closely to diagnose filtering problems
or interference from an adjacent band.

For applications where it is desirable to
focus the actual demodulation opera-
tions on a specific subcarrier or, more

typically, a range of subcarriers, the
Subcarrier Select function on the Ad-
vanced tab of the OFDMA Demodula-
tion Properties dialog box will provide a
solution. Since the demodulation itself
is actually restricted to the selected
subcarriers, the accuracy and robust-
ness of the demodulation (including
automatic recognition of modulation
type, if selected) will depend on the
signal quality of the selected subcar-
rier(s).

Selecting a specific set of subcarri-
ers may be particularly useful when

it is suspected that the signal under
test has an improper configuration of
the data burst map or an error in the
permutation formula. Demodulating

a very limited data set in this way

may present problems for automatic
recognition of modulation type, and it
may be helpful to use a Manual setting
for Data Tone Modulation as described
below.

For applications where it is desirable

to focus the measurement (if not the
entire demodulation result) on a spe-
cific subcarrier or range of subcarriers,
the Subcarrier Select function on the
Advanced tab of the OFDMA Demodu-
lation Properties dialog box will provide
a solution.

This example of frequency-specific
analysis will use the downlink record-
ing i80216e_DLPuscUniformQ64.sdf
supplied with the 89600 VSA software.
As described previously, perform

the Preset Setup function, recall the
recording, and recall its setup file:
i80216e_DLPuscUniformQ64.set. This
setup file will automatically clear the
Data Burst Analysis box on the Zone
Definition tab of OFDMA Demodula-
tion Properties, allowing for subcarrier
selection.

The data tone modulation type is
usually automatically detected by the
89600 VSA software. However, you
can also manually set the data tone
modulation, if needed, by going to the
Advanced tab of OFDMA Demodulation
Properties and clearing Use Default
Settings. This will allow you to change
Data Tone Modulation from Automat-
ic to Manual, as well as to select the
modulation format. Whether modula-
tion type is detected automatically or
set manually, the next step is to switch
from All to Subset in the Subcarrier
Select box, also on the Advanced tab.
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Advanced Digital Demodulation (continued)

Measurement results and displays will
now reflect only the desired subcar-
riers, as defined by the offset and
interval entries. The offset (a negative
or positive number) is the first num-
bered carrier to be included in the
measurement results, and the interval
(a positive number only) is the number
of adjacent subcarriers to include. If,
for example, the offset is set to -10
and the interval is set to 20, the 10
carriers on either side of the (untrans-
mitted) center carrier will be displayed
and measured, as shown in Figure 31.
In this figure, the X-axis of the error
vector spectrum display has been ex-
panded by a factor of 20 to show these
carriers more clearly. Note that you
will have to change the display format
of several traces in order to match
Figure 31.

If desired, one can combine measure-
ment of a specific set of subcarriers
with measurement of a specific symbol
or group of symbols, as described in
the previous example. This may be a
useful troubleshooting technique to
understand the effect of an impulsive
interference mechanism which affects
only a narrow frequency band. The
Time tab of the OFDMA Demodulation
Properties dialog box is used to gain
access to the Manual Measurement
Region settings. In this way you can
quantify the modulation quality of
something as small as a single symbol
on a specific range of OFDM subcar-
riers.

The Manual Measurement Region
setting may also be needed to properly
measure a subcarrier or (more typically
a range of subcarriers) in a zone where
different modulation formats are used
for subcarriers at different symbol
times in a subframe. Since the Subcar-
rier Select function only works in the
uniform data analysis mode, the modu-
lation analysis result must contain only
a single type of modulation for accu-
rate results. Isolating the calculation of
results to a specific symbol or symbols
will ensure that the result contains a
single modulation type.
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Figure 31. Analysis of a group of 20 OFDM subcarriers, centered around carrier 0. The
X-axis of the error spectrum display (upper right) has been expanded to show how the
selected carriers and the other measurement results are computed from only this subset

of the subcarriers.



Summary

By following the discipline of an or-
ganized measurement sequence, you
can uncover signal problems with your
OFDMA signals. Begin with basic spec-
trum measurements, then add vector
measurements, combining frequency
and time, before switching to basic
digital modulation analysis. After that,
you can take advantage of advanced or
standard-specific analysis.
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The 89600 VSA software contains so-
phisticated measurement and analysis
tools for time-selective or carrier-se-
lective measurements in either the
uniform data analysis or data burst
analysis modes. With these toals, the
VSA software can help you trouble-
shoot your signals quickly, and with an
unmatched depth of understanding.
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